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1 Descripcion del Hardware Utilizado en el Laboratorio

Los métodos de aprendizaje deben ser estructurados, graficos e ilustrativos. Para
aprender el disefio de dispositivos programables, hay que utilizar una herramienta. En
el mercado existe una gran diversidad de ellas. Altera tiene un programa universitario
con un software muy grafico e intuitivo complementado con un hardware de
verificacion.

1.1 Introduccion

A finales de los afios 90, el fabricante de dispositivos programables Altera creo el
Programa Universitario; el cual fue disefiado para cubrir las necesidades de los
profesores de universidad, que impartian clases sobre disefio digital basado en
dispositivos logicos programables. ElI Programa Universitario disponia de todo lo
necesario para crear e implementar disefios digitales, incluyendo las siguientes
caracteristicas:

e El software de desarrollo MAX+plus I, en su version 7.21 estudiantil.
e La Placa educacional UP1. Con los dispositivos:

o El dispositivo EPM7128S de la familia MAX7000S.

o El dispositivo EPF10K20 de la familia FLEX10K.
e Cable de programacion por puerto paralelo denominado ByteBlaster.

La electronica es una de las ciencias mas cambiantes que existen, lo cual implica que
actualmente el programa universitario de Altera haya evolucionado hacia otras
versiones mas actuales de software y de hardware.

El software de desarrollo MAX+plus I, incluia un completo flujo de disefio y un intuitivo
entorno grafico. La entrada del disefio se podia realizar mediante esquematicos o
mediante fichero de textos con descripciones hardware con VHDL. También disponia
de programaciéon, compilacion y verificacion de disefios para los dispositivos
EPM7128S y EPF10K20. Para maximizar el aprendizaje, el software de MAX+plus Il
incluia una completa e instantanea ayuda. Manteniendo esta filosofia MAX+plus I
evolucioné en el tiempo a través de diferentes versiones hasta alcanzar la version
10.2.

Tras la version 10.2 de MAX+plus II, Altera cambio el Programa Universitario hacia
una herramienta mas profesional, pero manteniendo la compatibilidad con el entorno
grafico de la anterior. El nuevo software de desarrollo para el Programa Universitario
se ha denominado Quartus Il, que actualmente se encuentra en su version 13.1.

La placa UP1 fue un experimento basado en dos dispositivos de Altera de las familias
MAX7000S y FLEX10K. Tiene un disefio simple, que usado con el software de
MAX+plus Il o Quartus Il, proporciona una plataforma para el aprendizaje del disefio
digital utilizando herramientas de desarrollo de alto nivel y PLDs.

La placa educacional UP1 fue disefiada para cubrir las necesidades de los educadores
y del laboratorio de disefio. La placa UP1 soporta tanto arquitecturas basadas en
productos términos como arquitecturas basadas en tablas de look-up (LUTS) e incluye
dos PLDs. EIl dispositivo EPM7128S puede ser programado en la propia placa por




medio de un cable usando la técnica del tipo ByteBlaster. El dispositivo EPF10K20
puede ser configurado utilizando también el cable ByteBlaster o por medio de una
memoria EPROM.

Con el tiempo, la placa educacional UP1 dio paso a la placa UP2, cuya principal
diferencia esta en que se sustituyo el dispositivo EPF10K20 por un EPF10K70, el cual
tiene el mismo encapsulado y patillaje. Por tanto, a partir de aqui se hablara de la
placa educacional UP, cuando se refiera a aspectos comunes a las dos.

A principios de 2004, Altera sacdé al mercado una nueva placa para educacién
denominada UP3, que supuso un cambio bastante radical en las caracteristicas de la
misma. La UP3 Unicamente incorpora un dispositivo el EP1C6 de la familia Cyclone, lo
cual impone la necesidad de utilizar Quartus Il como herramienta de disefo, ya que
MAX+plus Il no dispone de este dispositivo. La placa UP3 tiene un gran numero de
elementos adicionales como son un LCD, memorias, interface USB, conexion PS/2,
VGA, etc., que la hacen mas versétil. Todo ello hace posible que la placa UP3 también
se pueda utilizar para realizar disefios con Nios. Nios es lo que se denomina en ingles
un “softcore processor”; es decir un cuerpo de un microprocesador, que ha sido
disefiado por Altera y que se puede utilizar como un elemento mas del disefio.

La politica actual de Altera consiste en reducir al minimo el niumero de placas
educacionales que dispone, de tal manera que se utilice la misma placa para realizar
disefios digitales con dispositivos programables y disefios basados en Nios. Por todo
ello, a principios de 2006 sali6 al mercado la nueva placa denominada DE2
(Development and Education), por tratarse de un disefio para educacion y para
desarrollos.

Los disefios pueden ser facilmente cargados en la placa educacional, por medio del
cable de programacion, el cual es una simple interface de comunicacion entre el PC y
la placa. Este cable es un canal de comunicacién para transferir datos entre el
software (MAX+plus Il o Quartus Il) y la placa educacional. Debido a que los disefios
son cargados directamente en el dispositivo de la placa, resulta relativamente sencillo
probar un prototipo y cualquier cambio sobre el disefio puede ser testado de
inmediato.

1.2 Descripcion de la placa DE2

El elemento principal de la placa DE2 es la FPGA, es este caso una Cyclone II.
Alrededor de dicho dispositivo se emplazan un gran nimero de elementos que hacen
de la placa DE2 una herramienta muy verséatil para docencia, permitiendo implementar
un gran numero de disefios, desde sencillos circuitos digitales hasta complejos
proyectos multimedia. En la Figura 1.1 se puede ver una imagen de la placa DE2 en la
gue se muestran todos los elementos que la constituyen y su ubicacion, los cuales se
enumeran a continuacion:

e Dispositivo FPGA Altera Cyclone® Il EP2C35.

e Dispositivo Configuracion serie EPCS16.

e USB Blaster (en placa) para programacion y uso de las APIs de control. Acepta
la programacion por JTAG y AS (Active Serial).

e 512 kbyte SRAM.



e 8 Mbyte SDRAM.

¢ 4 Mbyte memoria flash.

e Conector para tarjetas SD.

e 4 pulsadores.

e 18 interruptores.

e 18 LEDs rojos.

e O LEDs verdes.

e 8 visualizadores 7-segmentos.

e Modulo de visualizacion LCD.

e Un oscilador de 50 MHz y otro de 27 MHz, para actuar como reloj.

e CODEC de audio de 24-bit calidad CD con conectores tipo jacks para linea de
entrada, salida y micréfono.

e Convertidor digital-analégico para VGA (Triple DAC de 10-bit alta velocidad)
con conector de salida VGA.

e Decodificador de TV (NTSC/PAL) y conector de entrada de TV.

e Controlador Ethernet 10/100 con conector RJ45.

e Controlador USB host-device con conectores USB del tipo A y del tipo B.

e Transceiver RS-232 y conector de 9 pines.

e Conector PS/2 para ratén o teclado.

e Transceiver IrDA.

e Dos conectores de expansion de 40 pines con diodos de proteccién.
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Blaster USB USB  Mic Line Line Video  \jigeo 10/100M RS-232

Device Host in In  Out |n Port Port
9V DC Power Supply L G
Connector I t t t 1 1 t 1 t t t
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\ | AT
24-bit Audio CODEC — o e e=> PSI2Port
TV Decoder
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PowerOsldlgF: : - Expansion Header 2 (JP2)
ek i1 (with Voitage Protection)
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Figura 1.1. La placa de Altera DE2.

Todos estos elementos que constituyen la placa DE2, se conectan fisica e
inamoviblemente, por medio de las pistas de la placa de circuito impreso, a los pines



del dispositivo Cyclone Il. Cada componente se conecta a uno o varios de las 672
patillas que tiene la FPGA. Para poder utilizar desde el dispositivo Cyclone Il uno o
varios de los elementos enumerados, habra que saber a cuél o a cuales de los pines
de la FPGA se conecta dicho componente. Esta informacion la facilita el fabricante de
la placa, que es el que ha establecido las conexiones y que a continuacién se detalla,
por medio de unas tablas, para aquellos elementos que se ha considerado que se van
a utilizar en el desarrollo de la asignatura.

La placa DE2 dispone de una configuracion precargada de fabrica, que permite
rapidamente ver sus caracteristicas. En el momento que se conecta la alimentacion de
la placa, se carga la configuracion de fabrica y se puede ver:

e Parpadear todos los LEDs.
e Todos los displays 7-segmentos, cuentan de 0 a F ciclicamente.
o En el LCD se muestra el mensaje “Welcome to the Altera DE2 Board”.

1.2.1 Las entradas de reloj

La placa DE2 de Altera incorpora dos osciladores que generan sefales de 27 MHz y
50 MHz. La placa también tiene un conector del tipo SMA, que permite la conexién de
una fuente de reloj externa. Es importante remarcar que para utilizar el reloj de 27 MHz
hay que poner a nivel légico alto el pin denominado “TD_RESET” que corresponde con
el nimero C4 del dispositivo Cyclone Il. En la Tabla 1.1, se muestra la lista de los
pines del dispositivo Cyclone Il que se conectan con las diferentes sefiales de reloj
comentadas.

Tabla 1.1. Asignacion de pines de la sefiales de reloj.

Nombre Numero Pin FPGA Comentarios
CLOCK 27 D13 Sefial de reloj de 27 MHz
CLOCK 50 N2 Sefial de reloj de 50 MHz

EXT_CLOCK P26 Sefal de reloj de externa.

1.2.2 Uso de los LEDs, interruptores y pulsadores

La placa DE2 tiene cuatro pulsadores, cada uno de los cuales tiene un circuito “Trigger
Schmitt”, para eliminar los rebotes al pulsar. Los cuatro pulsadores denominados de
KEYO a KEY3, se conectan directamente al dispositivo Cyclone Il. Cada pulsador
proporciona un nivel légico alto (‘1’) en reposo (cuando no esta pulsado) y un nivel
I6gico bajo (‘0’) mientras esta pulsado.

Hay 18 interruptores en la placa DE2, que no dispone de circuiteria eliminadora de
rebotes. Cada interruptor se conecta directamente a un pin del dispositivo Cyclone II.
Se encuentran en la parte inferior de la placa y se han denominado de SW0 a SW17.
Cuando el interruptor se encuentra hacia abajo (hacia el borde de la placa) genera un
nivel légico bajo (‘0’), mientras que cuando se encuentra hacia arriba genera un nivel
I6gico alto (‘1°).

La placa DE2 tiene 27 diodos LED, de los cuales hay 18 LEDs rojos situados cerca de
los 18 interruptores, 8 diodos LED verdes junto a los pulsadores y un diodo LED verde
adicional situado entre los displays 7-segmentos. Cada diodo LED se conecta



directamente a un pin del dispositivo Cyclone I, cuando se pone un ‘1’ I6gico en el pin
el LED se enciende, mientras que un ‘0’ légico mantiene el LED apagado.

En la Tabla 1.2, Tabla 1.3 y Tabla 1.4 se muestra la lista de los pines del dispositivo
Cyclone Il que se conectan con los interruptores, pulsadores y diodos LED
respectivamente.

Tabla 1.2. Asignacién de pines de los interruptores.

Numero Nombre NUmero Nombre Numero
Pin FPGA Pin FPGA Pin FPGA
SWIO] N25 SWI[6] AC13 SW[12] P2
SWI1] N26 SWI[7] C13 SWI[13] T7
SW[2] P25 SWI8] B13 SW[14] U3
SWI3] AE14 SWI[9] Al3 SW[15] u4
SWI[4] AF14 SWI[10] N1 SW[16] Vi
SWI[5] AD13 SWI[11] P1 SWI[17] V2

Tabla 1.3. Asignacién de pines de los pulsadores.

NUmero NUmero
Nombre o 'roga  Nombre o froea
KEY[O] G26 KEY[2] P23
KEY[1] N23 KEY[3] W26

Tabla 1.4. Asignacion de pines de los LEDs.

Nl’Jmero Nombre Numero Nl]mero

Pin FPGA Pin FPGA Pin FPGA
LEDRJ[O] AE23 LEDRJ[9] Y13 LEDGIO0] AE22
LEDRJ1] AF23 LEDRJ[10] AA13 LEDGI1] AF22
LEDRJ[2] AB21 LEDR[11] AC14 LEDGI2] W19
LEDR[3] AC22 LEDR[12] AD15 LEDGJ3] V18
LEDRJ[4] AD22 LEDR[13] AE15 LEDG[4] uils
LEDR[5] AD23 LEDR[14] AF13 LEDG[5] ul7
LEDR[6] AD21 LEDR[15] AE13 LEDG[6] AA20
LEDRJ[7] AC21 LEDR[16] AE12 LEDGI7] Y18
LEDR[8] AAl4 LEDR[17] AD12 LEDG[8] Y12

1.2.3 Los visualizadores 7-segmentos

La placa DE2 dispone de ocho visualizadores de 7-segmentos, los cuales se
encuentran agrupados en dos parejas de dos y un blogue de cuatro, permitiendo asi la
representacion de numeros de diferentes tamafios. Los siete segmentos de los
visualizadores se encuentran conectados a los pies del dispositivo Cyclone II.
Aplicando un nivel I6gico bajo en un segmento este se ilumina y con un nivel légico
alto se apaga.

Cada segmento del visualizador se identifica mediante un indice comprendido entre la
letra a y la letra g. Hay que destacar que el punto del visualizador no se encuentra
conectado y por tanto no se puede utilizar. En la Tabla 1.5 se muestra la asignacion de
pines y una imagen con el indice de cada segmento.
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Tabla 1.5. Asignacién de pines de los visualizadores 7-segmentos.

NuUmero Pin Numero Pin Numero Pin
Nombre FPGA Nombre EPGA Nombre EPGA
HEXO a AF10 HEX1 a V20 HEX?2 a AB23
HEXO b AB12 HEX1 b V21 HEX2 b V22
HEXO ¢ AC12 HEX1 c W21 HEX2 c AC25
HEXO d AD11 HEX1 d Y22 HEX2 d AC26
HEXO e AE1l HEX1 e AA24 HEX2 e AB26
HEXO f V14 HEX1 f AA23 HEX2 f AB25
HEXO g V13 HEX1 g AB24 HEX2 g Y24
HEX3 a Y23 a HEX4 a U9
HEX3 b AA25 HEX4 b Ul
HEX3 ¢ AA26 f | |b HEX4 ¢ U2
HEX3 d Y26 — HEX4 d T4
HEX3 e Y25 . | |c HEX4 e R7
HEX3 f U22 . HEX4 f R6
HEX3 g W24 d HEX4 g T3
HEX5 a T2 HEX6 a R2 HEX7 a L3
HEX5 b P6 HEX6 b P4 HEX7 b L2
HEX5 ¢ P7 HEX6 ¢ P3 HEX7 ¢ L9
HEX5 d T9 HEX6 d M2 HEX7 d L6
HEX5 e R5 HEX6 e M3 HEX7 e L7
HEXS5 f R4 HEX®6 f M5 HEX7 f P9
HEX5 g R3 HEX6 g M4 HEX7 g N9

1.3 Verificacion fisica de un disefio

Una vez disefiado y verificado el funcionamiento de un sistema digital mediante la
correspondiente simulacion, hay probar su funcionamiento en el hardware para el que
ha sido disefiado, lo que se conoce habitualmente como verificacion fisica. Para
probar un disefio en la placa DE2 de Altera hay que realizar los siguientes pasos:

1. Asignarle al disefio el dispositivo FPGA que tiene la placa DE2.
2. Realizar la correspondiente asignacion de pines.
3. Programar el dispositivo FPGA de la placa DE2.

En primer lugar hay que comprobar que cuando se cre6 el proyecto del disefio en
Quartus Il, se le asigno correctamente el dispositivo sobre el que se implementara
dicho sistema digital. La comprobacion del dispositivo se realiza en el menu
Assignments > Device de Quartus Il, ventana que se muestra en la Figura 1.2. En
este caso, la verificacion fisica del disefio se realizara sobre la placa DE2, cuyo
dispositivo es una Cyclone 1l con la referencia: EP2C35F672C6. Si el dispositivo
asignado no es el correcto, debe realizarse una compilacion del disefio antes de
proseguir.
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Figura 1.2. Ventana de asignacién del dispositivo.

La asignacion de pines consiste en indicar a que pin de la FPGA, debe conectarse
cada una de las sefiales de entrada y de salida del disefio que se quiere probar. Esto
requiere que en primer lugar se identifiquen las sefiales de entrada y salida del disefio
y a que pines de la FPGA deben de conectarse. En tablas anteriores se muestran
cuales son los pines de la FPGA en los que se conectan algunos elementos de la
placa DE2, como los LEDs, los interruptores, los pulsadores o los display 7-
segmentos.

La asignacion de pines se realiza en el menu Assignments > Pin Planner de Quartus
Il, ventana que se muestra en la Figura 1.3. En la parte superior de la Figura 1.3 se ve
una vista inferior del encapsulado del dispositivo. Los 672 pines que tiene la Cyclone
Il, se distribuyen en una matriz cuadrada en la que se enumeran las filas mediante
letras y las columnas mediante niumeros. En la parte inferior de la ventana mostrada
en la Figura 1.3, se ve la lista de sefiales de entrada y salida del disefio, para cada
sefial se indica el nombre (Node Name), la direccién (Direction), la conexion
(Location), y otros datos. Es en la columna de Location donde se debe especificar el
pin al que se quiere conectar la sefial. Por ejemplo, una sefial de reloj del sistema
(CLOCK_50) ira conectada al oscilador de la placa, segun la Tabla 1.1 el oscilador de
50 MHz se encuentra fisicamente conectado al pin N2 de la FPGA, por tanto en la
columna Location de la sefal se debe poner el valor N2.

Existe otra forma de realizar la asignacién de pines, la cual es dependiente de la
informacion que nos pueda facilitar el fabricante de la placa. Esta otra forma consiste
en importar un fichero que contiene la lista de asignaciones de pines y que nos facilita
el fabricante de la placa DE2 (DE2_pin assignments.csv). Este fichero en realidad
contiene una lista en la cual se relaciona un nombre de sefial prefijado por el
fabricante de la placa DE2 (valor que asocia con la columna Node Name) con un pin
del dispositivo (valor que se asocia con la columna Location). Sin embargo, esto
implica importar un gran namero de asignaciones, todas las de la placa DE2 alrededor
de 600, cuando en algunos casos solo se necesitan unas pocas, con lo cual las no
necesarias aparecen en el Pin Planner remarcadas con interrogantes. Notar que para
utilizar este método, es importante haber nombrado las sefiales de entrada y salida del

11
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disefio del mismo modo que aparece en el fichero de asignaciones. La importacion del
fichero de asignaciones se realiza mediante: Assignments > Import Assignments,
dando lugar a la ventana de la Figura 1.4.

(€ pin Planner - D:/qdesigns11/SDPAIT/kit - kit m . '.‘“ - .

File Edit View Processing Tools Window Help <]
Groups J X

Top View - Wire Bond

Named: = -
Node Name Direction Location Cydme Il - EP2C35F672C6
> & LEDG[7..0] Output Group

<<new group>>

Yolololeloleleleloremlelolele6 010 010l010t0ke}
©) OVOA

@é{éé‘ééo*@'@éﬁmwg

WMk 0EERE] 2 0 HG AR 8 9

i
t

a

AHEEE 3 < E <

| VAGOOOOOOAVOLVAROOCOOOAY

€ 7 8 910 11 121314 15K 0223 M%3

TR G e

< i, ] » ==l

X Named: * - Edit: X s/l ‘Fﬂtef: Pins: all >

& Node Name Direction Location 1/O Standard Reserved 1/0 Bank VREF Group Current Strength
9 CLOCK_50 Input PIN_N2 3.3V LV.. default) 2 B2.N1 24mA (default)
& LEDG[7] Output PIN_Y18 3.3V LV.. default) 7 B7_NO 24mA (default)
£ LEDG[6] Output PIN_AA20 3.3V LV..default) 7 B7_NO 24mA (default)
£ LEDG[5] Output PIN_U17 3.3V LV..default) 7 B7_NO 24mA (default)
£ LEDG[4] Output PIN_U18 3.3V LV..default) 7 B7_NO 24mA (default)
£ LEDG[3] Output PIN_V18 3.3V LV..default) 7 B7_NO 24mA (default)
£ LEDG[Z] Output PIN_W19 3.3V LV..default) 7 B7_NO 24mA (default)
£ LEDG[1] Output PIN_AF22 3.3V LV..default) 7 B7_NO 24mA (default)
£ LEDG[0] Output PIN_AE22 3.3V LV..default) 7 B7_NO 24mA (default)

- 1 sWo Input PIN_N25 3.3-VLV..default) 5 B5_N1 24mA (default)

£ |<<newnode>>

=

0% 00:00:00

Figura 1.3. Ventana de asignacion de pines, Pin Planner.

(& oy D =]
Specify the source and categories of assignments to import.
File name: D:/qdesigns 11/SDP/DE2_pin_assigr .CSV. E] Categories...
[¥] Copy existing assignments into kit.qsf.bak before importing
ok | cancel ][ e |

Figura 1.4. Ventana de importacion de asignaciones.

Una vez realizada la asignacion de pines se debe proceder a una nueva compilacién
ya que los pines deben incorporarse al disefio. Tras la compilacién se programara la
FPGA mediante el mena Tools > Programmer, que abre la ventana mostrada en la
Figura 1.5.

Asegurarse que la placa DE2 esté operativa pulsando el boton rojo de la misma, se
observa la iluminacion de multiples LEDs de la placa.

En la ventana Programmer, lo primero es asegurarse que se ha detectado la placa
DEZ2, si junto al botén Hardware Setup aparece la inscripcion No Hardware, significa
gue la placa no ha sido detectada, en cuyo caso hay que pulsar el botbn Hardware



Setup, para especificar como medio de comunicacion con la placa el USB Blaster.
Una vez verificado, que hay conexién entre el Quartus Il y la placa DE2, hay que
afadir (si no aparece ya en la ventana) el fichero que tiene el mismo nombre que el
proyecto y con extension .sof. Este fichero sof (SRAM Obiject File) contiene los codigos
binarios que permiten programar el dispositivo para que el disefio quede emplazado en
su interior. Se marca la casilla Program/Configure del fichero afadido. Y finalmente
se pulsa el boton Start para iniciar la programacion del dispositivo que sera visible en
la barra de progreso.

- I
File Edit View Processing Tools Window Help &
éaHardware Setup...| USB-Blaster [USB-0] Mode: |JTAG X Progress: [:
| Enable real-time ISP to allow background programming (for MAX II and MAX V devices)
File Device Checksum Usercode Program/  Verify  Blank-  Examine  Security Erase ISP
Configure Check Bit CLAMP
= kit.sof EP2C35F672 00301E13 FFFFFFFF vl
34 Auto Detect
¥ Delete T
& Add File...

m

Figura 1.5. Ventana de programacion del dispositivo.

1.4 ¢COémo archivar un proyecto en Quartus II?

Cuando se estéa trabajando en una herramienta de disefio electrénico como Quartus Il,
siempre surge la necesidad de copiar el trabajo realizado para poder llevarlo consigo y
asi poder trabajar en distintas maquinas o equipos. Como Quartus trabaja a nivel de
proyectos, lo mas inmediato es copiarse todo el subdirectorio del proyecto o
empaguetarlo en un archivo mediante una utilidad de compresion de archivos.

Sin embargo, Altera ha dotado a su herramienta Quartus de una utilizada que permite
archivar un proyecto, empaquetandolo en un Gnico archivo con la extension .gar. La
ventaja que presenta el uso de esta utilidad, es que automaticamente selecciona los
archivos realmente necesarios para su posterior uso, ademas como la extension .qar
esta enlazada con Quartus, con un simple doble click en el archivo se desempaqueta
el proyecto y se abre sobre Quartus.

Para archivar el proyecto que se esta actualmente en Quartus se debe proceder del
siguiente modo:

1. Seleccionar en el menu de Quartus: Project > Archive Project. Esto abre la
ventana del Archive Project, tal como se ve en la Figura 1.6.

2. En la ventana de la Figura 1.6, hay que establecer un nombre para el fichero
en el apartado: Archive file name.

3. Pulsando el boton de Advanced..., se abre la ventana de opciones tal como
muestra la Figura 1.7. Aqui se puede personalizar la seleccion de ficheros que
se deben incluir en el proceso de archivado del proyecto.
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4. Seleccionar en el File set la preconfiguracién Service request, tal como se
muestra en la Figura 1.7.

5. Pulsando el boton OK, se vuelve a la ventana del Archive Project.

6. Ahora, al pulsar en el boton Archive se creara el fichero donde se ha archivado
el proyecto, que tendra por nombre el que se ha especificado en Archive file
name y la extensién .gar. Este fichero se encontrara en el subdirectorio del
proyecto, a no ser que se haya indicado otro lugar.

Archive file name: motor

Advanced...

'@ Advanced Archive Settings
i i Py

File set: [Servsce request v] ‘

File subsets:

Project source and settings files Name A e

Automatically detected source files control_motor.v | Remove

[7] Incremental compilation database files 3

- motor.qpf =

Programming output files ol et

Reportfiles motor_assignment_defaults.qdf B l

E] Version corppatsble daFabase files testbench-Ut.qxp

Megafunction and IP library files Verifica_Motor.v

incremental_db/compiled_partitions/motor.db_

incremental_db/compiled_partitions/motor.ul_
incremental_db/imported_partitions/motor.ul,

motor.archive.rpt -
< | m | 3
Files to be archived: Total files: 24 Total size: 5091741 byte
4972 KB

Description:

Archives source files spedified in the project's Quartus II Settings File (.gsf). The best practiceistoadd
all source files to the project rather than having the compiler discover them. You can use the MISC_FILE
assignment to add files you wish to include in the archive; this assignment is not used during compilation. |=

Indudes the following files:

- Files specified by assignments with names ending in *_FILE", for example: VERILOG_FILE

- SignalTap II files specified by the following assignments: STP_FILE, USE_SIGNALTAP_FILE,
USE_LOGIC_ANALYZER_INTERFACE_FILE

- Files specified by the following assignments: TIMEQUEST_REPORT_SCRIPT, EDA_SDC_FILE_NAME, =

CNA TOOT DA CTICE AAME CNA CTAMLN ATTAA NI CANTAT CNA NTI TECT DEASW CTIE AAME

[ oc [ coned J[ b |

Figura 1.7. Ventana de opciones del archivado del proyecto.



2 Desarrollo de Testbench para Simulacién Empleando Modelsim

En la actualidad no es extrafio encontrar disefios que superen las decenas de millones
de puertas equivalentes (SoC / System on Chip). Es evidente que este tipo de chips no
se pueden realizar partiendo de cero con las condiciones habituales de mercado y por
ello se emplean bloques IP (Intellectual Property) que constituyen en si mismos
componentes de una elevada complejidad, listos para ser ensamblados dentro de un
sistema mayor. Incluso pudiendo confiar en el correcto funcionamiento de estos IP, las
labores de verificacion del sistema completo o SoC consumen hoy en dia entre el 70%
y el 80% del tiempo total de disefio. Es logico pues que el nimero de ingenieros que
trabajan en la verificacién de un disefio sea aproximadamente el doble que los que
trabajan en la parte RTL. Otro dato muy importante a tener en cuenta, es que debido a
las técnicas de reuso (empleo de IPs), la longitud de los testbenches supera la longitud
del cédigo RTL en la mayoria de los casos. Todo esto justifica con creces el desarrollo
de una metodologia de verificacién que sistematice el procedimiento.

2.1 El Testbench

La verificacion no es unicamente la creacion de un testbench. La verificacion es un
proceso mediante el cual se demuestra la correccion funcional de un disefio.
Empleando la verificacion podemos asegurarnos que nuestro disefio cumple con las
expectativas planteadas en la fase de especificacion. Bajo la denominacién de
procedimientos de verificacion se engloban una cierta cantidad de utiles que nos
permitiran trabajar a distintos niveles para poder avanzar con seguridad en el flujo de
disefio.

TestBench

DUV

Estimulos
sejsandsay

Entradas Salidas

Figura 2.1. Esquema de Verificacion.

El testbench sera la herramienta principal que nos permita ejecutar la verificacién. Un
testbench es un conjunto de cddigo generado para permitir la introduccion de datos
(sefiales etc) en el disefio bajo verificacion (D.U.V / device under verification) y la
observacion de sus respuestas; engloba al DUV (ver Figura 2.1) y constituye el ‘tubo
de ensayo’ donde se va a desarrollar nuestro trabajo. Dado que el testbench en si
mismo no va a ser sintetizado pueden emplearse multitud de lenguajes para su
descripcion VHDL, Verilog, SystemVerilog, C, etc. Sin embargo, debido al caracter
‘hardware’ del proceso, en el que se deberan de emplear condiciones temporales etc.
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se hace recomendable el uso de lenguajes HDL al menos en las partes que se
encuentran en contacto directo con el DUV.

2.2 El Simulador Modelsim-Altera

Las labores de verificacion de los circuitos precisan de simuladores HDL que permitan
la ejecucion de cédigo HDL a todos los niveles e incluso en ocasiones la mezcla de
distintos lenguajes tanto HDL como software. Modelsim (Mentor Graphics) es uno de
los simuladores interpretados mas potentes del mercado que se integra con la
herramienta de disefio Quartus Il en su version adaptada (y de prestaciones limitadas)
Modelsim-Altera. A continuacidn se describiran los pasos a seguir para configurar la
herramienta Quartus Il para ejecutar las simulaciones empleando Modelsim-Altera:

1. Durante la creacion del proyecto en Quartus Il seleccionar ModelSim — Altera
como herramienta de simulacién y Verilog HDL como formato de entrada, tal
como se muestra en la Figura 2.2.

EDA Tool Settings [page 4 of 5]

Specify the other EDA tools used with the Quartus I software to develop your project.

EDA tools:
Tool Type Tool Name Format(s) Run Tool Automatically
Design Entry/Synthesis I<None> v] <None> Run this tool automatically to synthesize the current design
Simulation IModeISim—AJtera - ”\u‘erilog HOL - I|:| Run gate-evel simulation automatically after compilation
Timing Analysis I<None> v] <MNone’= Run this tool automatically after compilation
Farmal Verification I<N0n2> - I
Board-Level Timing <Mone -
Symbaol <Mone: -
Signal Integrity <MNone: -
Boundary Scan <Monez -

Figura 2.2. Opciones de Simulacion en la creacién del proyecto en Quartus Il.

En caso de no haber seleccionado dichas opciones en la fase de creacion del
proyecto, seguir las opciones mostradas en la Figura 2.4.

Verificar que el path de instalacion de ModelSim se encuentra bien introducido
en Quartus Il. Para ello en el menu Tools > Options > EDA Tool Options
debe de figurar el directorio donde se encuentre modelsim (similar al que
aparece en la Figura 2.3)



Category:

4 General EDA Tool Options

EDA Tool Options

Fonts Specify the location of the tool executable for each third-party EDA tool:

Headers & Footers Settings

Internet Connectivity

Libraries LeonardoSpectrum

License Setup Predision Synthesis

Preferred Text Editor §

Processing Synpiify

Tooltip Settings Synplify Pro
4 Messages Active-HDL

Suppression
Colors Riviera-PRO

EDA Tool Location of Executable

Fonts ModelSim

QuestaSim

ModelSim-Altera C:VALTERA11.0'\modelsim_asewin32aloem
MNCSim

a@aaaEEaen

[7] Use MativeLink with a Synplify/Synplify Pro nodeJocked license

[ o

Figura 2.3. Path de ModelSim-Altera.

2. Puede ser que se disponga de un testbench o que se tenga que crear uno

nuevo desde cero. En el caso de disponer ya de los archivos del testbench, se
puede pasar directamente al siguiente punto. Si se tiene que crear un
testbench, hay que tener en cuenta que puede ser tan sencillo como describir
Unicamente los estimulos de entrada al DUV o tan complejo como ademas
afiadir métodos de analisis y comprobacion de las respuestas del DUV, para
determinar automaticamente si el funcionamiento es correcto. Por otra parte la
experiencia del disefiador hara que el testbench sea escrito desde cero o haya
que recurrir a las utiidades de ayuda que las herramientas de disefio
incorporan actualmente. En este sentido, Quartus dispone de la posibilidad de
crear un Template de testbench para el proyecto en el que se esta trabajando.

Para ello, se procederia del siguiente modo: Seleccionar en el menu
Processing > Start > Start Test Bench Template Writer. Quartus Il generara
un directorio dentro del proyecto: simulation/modelsim con un archivo
denominado [nombre proyecto].vt. Se trata de una plantilla para
desarrollar el testbench de nuestro médulo, donde se ha realizado:

a. Declaracién de las sefiales de conexion de entrada y salida del
DUV.

b. Instanciacion del médulo del DUV.

c. Descripcion de un bloque procedural initial para la inicializacion de
las sefiales que lo requieran.

d. Descripcion de un bloque always donde se ejecuta la introduccion
de Casos de Verificacion (CV) en el DUV. El esquema adoptado por
Quartus se basa en la declaracién de un reg denominado eachvec
que modifica su valor cada vez que se desea pasar a un caso de
verificacién nuevo. De ahi que después de cada bloque donde se
realiza la introduccion del CV se introduzca un control de ejecucion
que espera a un cambio en eachvec.
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Sin embargo, este modo de procedimiento sélo es adecuado para disefio de
baja complejidad donde el testbench sea muy simple. Para el resto de
situaciones se recomienda crear el testbench empleando un editor de texto

externo.

Category:

7 secog ot o |~ -
M... y

General
Fies
Libranes
4 Operatrg Settngs and Condaons
Voltage
Temperatoe
# Complation Process Settngs
Larly Tewng Estmate
Ingements Complation
Pryscal Symhess Opamzatons
4 EDA Yool Setergs
Desgn Enry Synthess
Sendaton
Farmal Verificaton
BowddLevel
4 Analyss & Synthess Settngs
VHOL Input
Veriog HOL Ingut
Defaut Parameters
Fitter Settrgs
TmeQuest Teng Analyzer
Asgembier
Deson Assistant
SoraiTap 11 Logc Analyzer
Loge Analyzer interface
PowerPay Power Acfyder Settngs
SEN Acalyper

Simedatson

Speafy aptions for generatng cutput fles for use with other EDA to0is.

Tool rame: | ModeiSm-Aers -
Faun gatedevel smulation automatcally after complation

EOA Netist Writer settngs
Eormat for cutput retist: | Venfog HOL - Time geale: 1ps |
Ouput dreciony:  semuationmodeism

Moo Segal HEX characters
Optons for Power Estimation

Enadse ghtch Sterng

Generate Value Change Dump (VCD) e sopt

R FO S

More EDA hetist incer Settrgs...
Natvelrk settrgs
hore
@ Comple testbendh: | Touh Contol » | [Test gonches...
\se 50Ot 10 set Lp simulation:
5ot o comple test bench:

[More tatetirk Settnga... et

Figura 2.4. Opciones de configuracién I.

3. Configuracion de Quartus Il para la simulacion con ModelSim:

a. En el mend Asignments > Settings > EDA Tools Setings >
Simulation emplear las opciones descritas en la Figura 2.4.

b. En la opcién Test Benches sera necesario incluir el testbench y todos
los ficheros de apoyo empleados en la simulacion (MFB, Modelos de
Verificacion, etc.) que vayan a ser compilados en Modelsim. Para ello
seleccionar Test Benches > New... y emplear las opciones descritas
en la Figura 2.4. En estas opciones se indica:

i. El nombre del modulo que implementa el testbench.
i. El nombre de la instancia del DUV para aplicar los retardos
obtenidos en la fase de extraccion.
ii. El periodo de tiempo de simulacion (el indicado en el propio
testbench o bien uno que se forzara en este punto).
iv. El fichero que contiene el testbench mediante la opcién Test
bench Files > Add...



c. Sitodo se ha realizado correctamente en la opcion Compile test bench
del menu de la Figura 2.4, aparecera la opcion del testbench que se ha
introducido.

Edit test bench settings for e selecied best bendh.

Test bench name: & _Teuach_Corvirall
Top level modile in testbench; i _Tewsh_Cantrel
o s test bench o pesfoes VHDL brvarg Semwla b
[Pemgn irstance name 0 fest Dend | ADE_OOMTRCL
Samula bon period
& Fun simulabion unbl sl yechor steeull ore Led
End simailsnon st

Tiesst bench fies
Bl rame!

Fle Mated LW Sy HOL Vierses
EMLLE &5 v
& _Tiouch_Conde Default
MFlLv O falt

Figura 2.5. Opciones de configuracion Il.

Si la instancia del DUV emplea parametros, su valor debera de ser el
mismo que el empleado en la Compilacién del disefio en Quartus |l.

4. La simulacion puede realizarse de dos formas distintas:

a. Tools > Run EDA Simulation Tools > Run RTL Simulation. Permite
realizar una simulacién del c6digo RTL previa al proceso de sintesis e
implementacion. Se emplea esta opcion por defecto para descartar
problemas de temporizacion.

b. Tools > Run EDA Simulation Tools > Run Gate Level Simulation.
Permite realizar una simulacién de tipo GATE LEVEL, es decir del
resultado de los procesos de sintesis e implementacion. Se afiaden los
retardos e informacion temporal del disefio empleando un modelo de
caso peor (Slow Model) o un modelo de caso mejor (Fast Model).

En cualquiera de las dos opciones, Quartus Il llamara a ModelSim ejecutando una
compilaciéon y simulacion en éste ultimo. Los puertos de entrada y salida del DUV se
muestran con los resultados de la simulacion y en la consola del simulador pueden
verse los mensajes emitidos por el testbench respecto al funcionamiento de la
simulacion (ver Figura 2.6).
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Figura 2.6. Resultado de la simulacion.

2.3 Uso del WaveForm de Quartus como generador de Testbench para
Modelsim-Altera

Tal como se ha comentado en el apartado anterior, a la hora de realizar una
simulaciéon utilizando Modelsim-Altera, es necesario realizar o disponer de un
testbench. Para aquellos disefiadores noveles que estan habituados al uso de
herramientas graficas de generacion de estimulos, para la realizacién de simulaciones,
resulta un poco complicado iniciarse en la escritura textual de estimulos para la
creacion del testbench. No obstante, siempre se pueden encontrar utilidades o ayudas
que faciliten esta tarea.

Ahora, se puede utilizar el editor de formas de onda de Quartus, para crear un
testbench inicial que se utilizara para realizar la simulacion empleando Modelsim-
Altera. El procedimiento a seguir serd el siguiente:

1. Una vez se tiene el proyecto de Quartus compilado, desde el menu File >
New... se una ventana, en la que dentro del apartado de
Verification/Debugging Files eligiendo la opcién University Program VWF
tal como se ve en la Figura 2.7, se abre el editor de formas de onda de
Quartus.

2. En el editor de formas de onda (Simulation Waveform Editor), se crean los
estimulos que se tienen que aplicar al disefio se afiaden también aquellas
sefales cuyos valores se quieren visualizar, tal como se ve en la Figura 2.8. Se
guardan los estimulos con el nombre, por ejemplo waveform01 . vw£.

3. En el menud del Simulation Waveform Editor se escoge Simulation > Generate
ModelSim Testbench and Script (ver Figura 2.9), lo cual generara en el
subdirectorio del proyecto simulation/modelsim dos archivos:
waveform0l.vwf.vt Yy waveformOl.vwf.do. El primero de ellos es el
archivo de texto del testbench con los estimulos que se han generado. El
segundo es un archivo de script que permitird lanzar la simulacion desde
Modelsim-Altera.



File Edit View Simulation Help

New Quartus II Project

4 Design Files
AHDL File
Block Diagram/Schematic File
EDIF File
Qsys System File
State Machine File
SystemVerilog HDL File
Tdl Script File
Verilog HDL File
VHDL File

4 Memory Files
Hexadecimal (Intel-Format) File
Memory Initialization File

4 Verification/Debugging Files
In-System Sources and Probes File
Logic Analyzer Interface File
SignalTap II Logic Analyzer File
|University Program VWF

4 Other Files
AHDL Indude File
Block Symbol File
Chain Description File
Synopsys Design Constraints File
Text File

o [ concel J[ rep |

Figura 2.7. Crear nuevo editor de formas de ondas.
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Figura 2.8. Editor de formas de onda.

' File Edit View

@ & x=><o' g Options

Run Functional Simulation

7 {

- s
Master Time Bar: @ ™ .26 ns

Run Timing Simulation
. Generate ModelSim Testbench and Script 240.0ns
Name U
ups P
B | ok 80

B

Figura 2.9. Menu de generacion del testbech.

4.

Ahora, solo hay que configurar Quartus para lanzar la simulacion utilizando
Modelsim-Altera. Aunque la configuracion se puede hacer utilizando el archivo
de tesbench (waveform01l.vwf.vt), tal como se ha explicado anteriormente
y se muestra en la Figura 2.4. Se puede simplificar ligeramente el proceso
utilizando el script (waveformOl.vwf.do) generado, en cuyo caso la
configuracion se realizaré tal como se muestra en la Figura 2.10.
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Files
Libraries Specify options for generating output files for use with other EDA tools.
4 QOperating Settings and Conditions B
| Voltage Tool name: [ModelSim-Altsefa b ]
Temperature = Z s S 275
4 Compilation Process Settings IT} Run gate-evel simulation automatically after compilation
Early Timing Estimate < > %
J Incremental Compilation EDA Netiist Writer settings
Physical Synthesis Optimizations Format for output netlist: | Verilog HDL A Time scale: [ ips v ]
4 EDA Tool Settings
Design Entry/Synthesis Output directory:  simulation/modelsim
Simulation = =
Formal Verification [} Map illegal HDL characters [] Enable glitch filtering
Board-Level Options for Power Estimation
4 Analysis & Synthesis Settings
VHDL Input [] Generate Value Change Dump (VCD) file script | Script Settings...
Verilog HDL Input
Default Parameters Design instance name:
Fitter Settings
TimeQuest Timing Analyzer
Assembler More EDA Netlist Writer Settings.. ]
Design Assistant s o s
SignalTap II Logic Analyzer Nativelink settings
Logic Analyzer Interface ) None
PowerPlay Power Analyzer Settings
SSN Analyzer (Z) Compile test bench: v | |Test Benches...

Use script to set up simulation:

@ Script to compile test bench:  simulation/modelsim/lcd_sync.vwf.do
More NativeLink Settings... Reset

Figura 2.10. Configuracion de la simulacién en Quartus.

5. La simulacion puede realizarse de dos formas distintas:

a. Tools > Run EDA Simulation Tools > Run RTL Simulation. Permite
realizar una simulacion del c6digo RTL previa al proceso de sintesis e
implementacion. Se emplea esta opcion por defecto para descartar
problemas de temporizacion.

b. Tools > Run EDA Simulation Tools > Run Gate Level Simulation.
Permite realizar una simulacién de tipo GATE LEVEL, es decir del
resultado de los procesos de sintesis e implementacién. Se afiaden los
retardos e informacion temporal del disefio empleando un modelo de
caso peor (Slow Model) o un modelo de caso mejor (Fast Model).

En cualquiera de las dos opciones, Quartus Il llamara a ModelSim ejecutando una
compilaciéon y simulacion en éste ultimo. Los puertos de entrada y salida del DUV se
muestran con los resultados de la simulaciéon y en la consola del simulador pueden
verse los mensajes emitidos por el testbench respecto al funcionamiento de la
simulacion (ver Figura 2.6).



3 Diseno de Sistemas Secuenciales

3.1

3.2

3.21

Objetivos

Aprender los conceptos béasicos del leguaje Verilog HDL y su uso en la
realizacion de disefios.

Incidir en el uso de bloques procedurales gobernados por el reloj para la
modelizacion de circuitos secuenciales

Realizacién practica de algunos disefios digitales utilizando el lenguaje Verilog
HDL.

Conocer c6mo se realiza la jerarquia en Verilog HDL y el uso de parametros.

Repaso conceptos tedricos

Procesos secuenciales

Los procesos secuenciales son aquellos de los que hacemos uso para modelizar
circuitos secuenciales. Las reglas y recomendaciones basicas que se deben tener en
cuenta cuando se modeliza un circuito secuencial mediante un proceso secuencial son
las siguientes:

En un proceso secuencial aparece una (y solo una) sefial de reloj. Esto es
evidente pensando en el circuito secuencial sincrono que se esta
modelizando. La afirmaciéon anterior implica que en un proceso secuencial
debe aparecer una (y solo una) alusion a un flanco de una sefial, es decir una
construccion del tipo @ (posedge ..) 0 @ (negedge ..).

Un circuito secuencial es sensible a los flancos de la sefial de reloj y a las
entradas asincronas. Esto implica que el proceso secuencial que lo modeliza
debe tener una lista de sensibilidad que incluya la sefal de reloj y las entradas
asincronas si las hubiera (normalmente un reset asincrono), por ejemplo:
@ (posedge clk or negedge reset). Algunos sintetizadores limitan el
namero de sefiales asincronas que pueden acompafiar a la sefial de reloj en la
lista de sensibilidad. De todo lo anterior se deduce que si se estd modelizando
un circuito secuencial absolutamente sincrono en todo su funcionamiento, solo
debe aparecer la sefial de reloj en la lista de sensibilidad.

La estructura Unica y basica de todo proceso secuencial es un “if else if
else” que debe englobar toda la descripcion. Como se sabe esta estructura
implica prioridad (segun el lugar en el que aparecen). Deberan comprobarse
las sefiales de entradas més prioritarias en primer lugar. Estas sefiales se sabe
gue son, en los circuitos secuenciales, las sefiales asincronas.

Todas las asignaciones no blogueantes de sefiales que se realicen dentro
de un proceso secuencial van a inferir flip-flops por cada una de ellas. Si se
quiere que una asignacion infiera un simple cable sin afiadir flip-flops
adicionales, debe ser realizada dicha asignacion fuera del proceso.

El orden de las asignaciones bloqueantes determina que es sintetizado (es
decir si infiere o no flip-flops) mientras que con las asighaciones no
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blogueantes de sefiales, como se ha indicado en el parrafo anterior, es
indiferente: siempre infiere flip-flops. Esto hace que uno deba ser muy
cuidadoso con lo que hace cuando se trabaja con las asignaciones
blogueantes de sefiales, mientras que con las no bloqueantes todo es mas
previsible y por tanto mas comodo de trabajar.

e Se recomienda por lo tanto trabajar exclusivamente con asignaciones no
blogueantes de sefiales en el interior de los procesos secuenciales. Las
plantillas templates y ejemplos de ALTERA no hacen caso de esta
importantisima recomendacién y o0s pueden conducir a innumerables
problemas en vuestros disefios. Cuidado.

Tabla 3.1. Ejemplo de uso de asignaciones bloqueantes de sefiales.

Registro de desplazamiento MAL Registro de desplazamiento BIEN
descrito descrito
/module SHIFT REGISTER (SIG_IN, /module SHIFT REGISTER (SIG_IN,
CLK_SYSTEM, SIG_OUT); CLK_SYSTEM, SIG OUT);
output SIG OUT; output SIG OUT;
input SIG_IN, CLK_SYSTEM; input SIG IN, CLK_ SYSTEM;
reg A, B, C; reg A, B, C;
always (@ (posedge CLK_SYSTEM) always @ (posedge CLK SYSTEM)
begin begin
A = SIG_IN; C = B;
B = A; B = A;
C = B; A = SIG_IN;
end end
assign SIG OUT = C; assign SIG OUT = C;
endmodule endmodule
SIG_IN A B c
~>—1D —{D — D — >
SIGIN[>——D Q—{ > sic_out @ ° ? SIG_OUT
CLK_SYSTEM [_>—DCLK [= CLK l’ CLK I_ CLK
CLK_SYSTEM




Tabla 3.2. Ejemplo de uso de asignaciones no bloqueantes de sefiales: RECOMENDADO.

Registro de desplazamiento BIEN

descrito

CLK_SYSTEM, SIG_OUT);
output SIG OUT;

input SIG IN, CLK SYSTEM;
reg A, B, C;

always @ (posedge CLK SYSTEM)

begin
A <= SIG IN;
B <= A;
C <= B;

end

assign SIG OUT = C;
endmodule

SIG_IN A B C

D Q—D QHD Q—f >

SIG_OUT
|:>—|» CLK l- CLK I- CLK

CLK_SYSTEM

///;;dule SHIFT REGISTER (SIG IN,

Registro de desplazamiento BIEN
descrito

///;;dule SHIFT REGISTER (SIG IN,

CLK SYSTEM, SIG OUT);
output SIG OUT;

input SIG IN, CLK SYSTEM;
reg A, B, C;

always @ (posedge CLK SYSTEM)

begin
C <= B;
B <= A;

A <= SIG_IN;
end

assign SIG OUT = C;

endmodule

SIG_IN A B C

D Q—D QHD Q—f >

SIG_OUT
|:>—|» CLK l- CLK I- CLK

CLK_SYSTEM

3.2.2 Diseiio jerarquico en Verilog HDL

Es muy sencillo establecer jerarquia en Verilog HDL. Para ello sélo se tiene que
instanciar el modulo que se quiere utilizar en la descripcion. La instanciacion de
maédulos en Verilog HDL se realiza de la siguiente forma:
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module AOI str (y out, x inl, x in2, x in3, x in4, x inb5);
output y out;
input x inl, x in2, x in3, x ind4, x in5;

//Definicidén de nodos intermedios
wire yl1, vy2;

//Instanciacidén de los mdédulos

nor (y out, yl, y2);

and (yl, x inl, x in2);

and (y2, x in3, x in4, x inb);
endmodule

AOI_str
x_inl
[
x_in2
[
yl
y_out
x_in3
[ 2
X_in4 L y
[
x_in5
= ]

Figura 3.1. Ejemplo de uso de jerarquia en Verilog HDL.

El esquema de la Figura 3.1, muestra la construcciébn de un bloque denominado
AOI_str a partir de instancias de puertas and y nor. Para la interconexion de los
maddulos entre si sera necesaria la declaracion de nodos internos de tipo wire. Por otra
parte, una misma descripcién en Verilog HDL puede combinar instancias de modulos,
primitivas, asi como otras estructuras. La utilizacion que se esta haciendo de Verilog
HDL en este ejemplo es puramente estructural. Es decir, se esta creando lo que en
las herramientas de disefio asistido por ordenador (CAD) se denomina un netlist: un
listado de instancias de mddulos junto con sus interconexiones.

El verdadero potencial de Verilog HDL reside en su capacidad de describir el
comportamiento de circuitos digitales mediante un lenguaje de alto nivel, dejando a la
herramienta (en este caso Quartus Il) la tarea de trasladar del dominio
comportamental al dominio estructural.

3.2.3 Lareutilizacién de los disefos

Un disefiador eficiente debe saber rentabilizar el tiempo que dedica a realizar los
disefios. Por ello, es importante saber reutilizar los médulos o bloques anteriormente
disefiados. Una cualidad de los lenguajes HDL, que permite incrementar las
posibilidades de reutilizar un disefio, es la parametrizacion de los mismos. Por




ejemplo, en muchas ocasiones se requiere el uso de un contador, si previamente se
ha realizado ese contador se puede reutilizar. Sin embargo puede ocurrir (y ocurrira)
gue el contador realizado sea de 8 bits y el que se necesite de 10 bits. La solucion
parece sencilla, se toma la descripcién del contador de 8 bits y se modifica para hacer
uno de 10 bits. Esto tiene el inconveniente de tener que disponer de una coleccion
distinta de archivos con modelizado de contadores para diferentes tamafos.

La mejor solucion es disponer de un solo archivo con el modelo del contador, de tal
manera gque este se haya realizado dependiente de un pardmetro de configuracion,
que se cambiard en funcion de las necesidades. En la Figura 3.2 se muestra el
ejemplo de un multiplexor de bus de tamafio parametrizable, en ella se pueden ver dos
formas distintas de utilizar los parametros.

module mux module mux (out, A, B, sel);
# (parameter WIDTH = 4) parameter WIDTH = 4;
(output [WIDTH-1:0] out, output [WIDTH-1:0] out;
input [WIDTH-1:0] A, B, input [WIDTH-1:0] A, B;
input sel); input sel;
assign out = (sel) ? A: B; assign out = (sel) ? A: B;
endmodule endmodule

Figura 3.2. Ejemplos de disefio parametrizable.

En la Figura 3.3, se muestra a su vez diferentes formas de instanciar el médulo creado
en la Figura 3.2. En primer lugar se instancia un multiplexor de 8 bits de bus. En el
segundo caso se parametriza con 10 bits, utilizando una sintaxis de conexién por
nombre, en lugar de posiciébn como se utiliza en el primer caso. Tal como se aprecia
en un mismo modulo se puede instanciar varias veces el mismo componente con
distintos valores en sus parametros.

module Top (..);
mux #(8) ul (a, b, c, 4d);
mux # (.WIDTH(10)) u2 (.out(s), .A(x), .B(y), sel(z));

endmodule

Figura 3.3. Ejemplo de instanciacion de modulos parametrizables.

Para completar el uso de parametros, en ocasiones puede ser necesario realizar
operaciones matematicas con el parametro antes de utilizarlo dentro del disefio. Por
ejemplo, se quiere a partir de un dato obtener el nimero de bits necesario para poder
alcanzarlo. Volviendo al ejemplo del contador, en lugar de fijar como parametro el
ndimero de bits, se establece el valor del fin de cuenta, en este caso ¢Como se obtiene
el nimero de bits que debe tener el contador? La solucion es recurrir al uso de una
funcion que permita obtener el nimero de bits a partir del dato de fin de cuenta. En la
Figura 3.4 se muestra un ejemplo de cémo hacerlo utilizando la funcion: CLogB2, que
calcula el logaritmo en base 2, con redondeo al entero mas proximo. Tal como se
aprecia la funcion CLogB2, permite obtener el valor de cuantos bits hacen falta para
alcanzar el fin de cuenta establecido. La funcién CLogB2 se encuentra definida en el
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fichero de funciones matematicas denominado MathFun.vh, que habra que incluir
previamente en el disefio.

module contador
# (parameter fin cuenta=20)

(...) 7

“include "MathFun.vh"
parameter WIDTH=CLogB2 (fin cuenta-1);

endmodule
Figura 3.4. Ejemplo de uso de funciones para el calculo de parametros.

3.3 Estructura de la practica

Todo disefio de sistema secuencial va gobernado por una sefial de reloj, proveniente
de un oscilador externo al dispositivo, en el que se implementa el disefio. En la placa
DE2 el oscilador que se dispone tiene una frecuencia de 50 MHz, lo cual significa que
los cambios de las sefiales se produciran cada 20 ns. Cuando se realizan disefios para
controlar o utilizar elementos de visualizacion perceptibles por el ojo humano, hay que
tener presente que cambios con un tiempo inferior a 50 ms, no son visibles por los
humanos. Asi que, no se puede utilizar directamente el oscilador de 50 MHz para
realizar cambios que deben ser visibles por el ojo humano; por ejemplo, hacer que un
LED parpadee.

En esta practica se ve como solucionar este problema de visualizaciéon, manteniendo
los criterios de un correcto disefio sincrono en que todos los flip-flops del disefio deben
estar gobernados por la misma sefial de reloj.

La préactica de disefio de sistemas secuenciales con Verilog HDL esta estructurada de
la siguiente forma:

1. Realizacién de contadores en Verilog HDL.
2. Realizacion de registros de desplazamiento.
3. Realizacién del juego de luces del coche fantastico.

3.4 Desarrollo de la practica
3.4.1 Tarea 1.1 - Realizacion de un Contador con Verilog HDL

Realizar un contador binario, mediante descripcion Verilog HDL que tenga las
siguientes caracteristicas:

e Contador sincrono ascendente-descendente de 8 bits, médulo 256.

e Funcionamiento por flanco de bajada del relo;.

e Reset, asincrono, activo a nivel bajo.

e Carga paralelo sincrona, habilitada mediante una sefial activa a nivel bajo.



3.4.2

Tarea 1.2 — Contador parametrizable

Realizar un contador binario, mediante descripcion Verilog HDL que tenga las
siguientes caracteristicas:

343

Contador sincrono ascendente-descendente de mddulo parametrizable
PARAMETER.

Funcionamiento por flanco de subida del reloj.

Reset, sincrono (maxima prioridad), activo a nivel bajo.

Entrada de habilitacién de cuenta enable que habilita la cuenta.

Sefial de salida TC activa cuando el contador llega al fin de cuenta.

Tarea 1.3 — Registro de desplazamiento

Realizar un registro de desplazamiento mediante descripcién Verilog HDL, cuyas
caracteristicas sean las siguientes:

3.44

Registro de desplazamiento de 7 bits sincrono.

Reloj activo por flanco de subida.

Linea de reset sincrona, activa a nivel bajo.

Entrada serie.

Salida serie.

Salida paralelo.

Entrada de habilitacion de desplazamiento enable que permite el
desplazamiento.

Tarea 1.4 - Diseio del juego de luces del coche fantastico

Realizar en los LEDs verdes LEDG7 a LEDGO de la placa DE2 el juego de luces
siguiente:

Ciclos LEDG7 | LEDG6 LEDG5 LEDG4 LEDG3 LEDG2 LEDG1 | LEDGO |

En este disefio debe reutilizar el contador parametrizable de la Tarea 1.2, y el registro
de desplazamiento de la Tarea 1.3, con las siguientes consideraciones:
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e El contador (que cuenta con la sefial de reloj de la placa DE2 de 50 MHz) se
empleard para habilitar con su salida TC la sefial de enable del registro de
desplazamiento, de forma que el desplazamiento sea cada 0,25 segundos.

o El registro de desplazamiento debe funcionar como un contador Johnson, por
lo que generara 14 estados que corresponderan a los 14 ciclos del juego de
luces.

e Ademas deberd crear un decodificador que a partir de los estados del
contador Johnson genere la salida a los LEDs de LEDG7 a LEDGO.

e El enable del contador debe estar manejado por el estado del interruptor
SWIOQ], de la placa DE2.

El tope de la jerarquia del disefio debe ser un fichero Verilog HDL en donde se realice
la instanciacion del contador y del registro de desplazamiento, y el cddigo asociado al
proceso del decodificador. Tome como punto de partida el codigo mostrado y el
diagrama de bloques siguiente de la Figura 3.5 para saber cémo crear el mapeo.

module kit ( //Declare los puertos del mdbébdulo );

// Declare las seflales necesarias

contador
# (.modulo (valor del modulo))
u0 ( .clock (CLOCK 50),

// Complete las demés asociaciones

) ;

registro
ul ( .clock (CLOCK 50),
// Complete las demds asociaciones

) ;

always @(//lista de sensibilidades)
begin

// Cédigo del decodificador
end

// Asignaciones de sefial necesarias

endmodule
‘1'— UP/DOWN COUNT ¢ummm L SHIFT_IN SHIFT_OUTJ
KEY[0]—| RST_n KEY[0]—| RST_n
CONTADOR REGISTRO PROCESO DE
CLOCK_50— » CLK TC CLOCK_50 —{» CLK ouT P DECODIFICACION LE..E.)G7
) ENABLE —‘ - e T DE LOS LEDS Le0G0
]

SWO]

Figura 3.5. Diagrama de bloques de KIT.



Procure que el nombre de los puertos del modulo coincida con el nombre que tiene la
asignacion de los pines de la FPGA en la placa DE2. Estas asighaciones estan en el
fichero DE2_pin_assignments.csv que esta disponible en Recursos de la Asignatura
en PoliformaT. Para utilizar estas asignaciones ejecute el comando Import
Assignments del mend Assignments. De esta manera se ahorrara el tener que
realizar las asignaciones de pines una a una tal y como ya hizo en la practica anterior.
Debera definir los puertos asignados a los pines identificados como bus (por ejemplo
SWI[0] input [0:0] SW y los LEDG output [7:0] LEDG, Yy luego emplearlas
como bus en Verilog HDL (por ejemplo SW[0], LEDG<=8"'b00100000).

Verifique su correcto funcionamiento en la placa DE2.
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4 Diseno de Maquinas de Estado Finitos

En sistemas digitales de una cierta complejidad siempre es necesaria la utilizacion de
una unidad de control que gestione el funcionamiento del mismo. Las unidades de
control son generalmente maquinas de estados finitos, y por tanto de su correcto
funcionamiento depende todo el sistema.

4.1 Objetivos

e Aprender los conceptos basicos del leguaje Verilog HDL y su uso en el disefio
de maquinas de estados finitos.

e Aprender las principales formas constructivas para maquinas de estados finitos
del leguaje Verilog HDL.

o Aprender las particularidades del disefio de maquinas de estados finitos en
Quartus Il.

e Aprender a verificar el funcionamiento del disefio introduciéndolo en un sistema
de prueba disefiado expresamente para él.

e Realizacion practica de algunos disefios digitales de maquinas de estados
utilizando el lenguaje Verilog HDL.

4.2 Introduccion teoérica

4.2.1 Maquinas de estados finitos en Quartus Il

En las clases tedricas de la asignatura se explica, de modo general, como se realiza la
descripcion de una maquina de estados utilizando un HDL como Verilog HDL. Sin
embargo, cada herramienta de sintesis HDL, suele tener sus propias peculiaridades
gue permiten identificar una descripcion HDL como la descripcion de una maquina de
estados finitos. A continuacibn se mostraran las particularidades que Altera
recomienda para que Quartus Il, reconozca que la descripcion HDL corresponde con
una maquina de estados.

Para asegurar un adecuado reconocimiento de la maquina de estados y obtener unos
buenos resultados de implementacion, Altera recomienda seguir las siguientes
recomendaciones:

e Asignar un valor por defecto a todas las sefiales de salida que se generen en la
maquina de estados, para evitar la inferencia de latches o realimentaciones
combinacionales.

e Separa la l6gica de la maquina de estados de cualquier funcion aritmética, data
paths e incluso de la asignacion de valor a las salidas.

e Si el disefio contiene una operacion que se va a utilizar en mas de un estado,
habrd que definir la operacioén fuera de la méaquina de estados y crear las
salidas necesarias en la maquina para utilizar dicha operacion.

e Utilizar un reset, asincrono o sincrono, para definir un estado para el arranque
0 power-up.

e Representar los estados de la maquina de estados mediante datos del tipo
parametro (parameter). La implementacion de estos pardmetros hace que la
maquina de estados sea facil de leer y reduce el riesgo de errores durante la
codificacion.

33



o Altera recomienda utilizar directamente valores enteros en la variable de
los estados, como next state <= 0.
No se infiere una maquina de estados en Quartus Il, si para la transicion del
estado se utilizan operaciones aritméticas, por ejemplo:

case (state)
0: begin
if (ena) next state <= state + 2;
else next state <= state + 1;
end
1: begin

endcase

No se infiere una maquina de estados en Quartus Il, si la variable del estado es
una salida.

No se infiere una maquina de estados en Quartus Il para variables con signo.

Si se tiene cualquier duda de cémo se implementa y que se reconozca una maquina
de estados en Quartus Il, siempre se puede recurrir a las plantillas (Templates). En
las plantillas se pueden encontrar los esqueletos para la descripcion de cuatro tipos de
maquinas de estados:

Maquinas de Moore.

Maquinas de Mealy.

Maquinas Seguras. Descripcion de una maquina de estados que evita la
existencia de estados espurios o no definidos.

Magquinas con codificacion de estados fijada por el disefiador.

A continuacioén se puede ver el aspecto de la plantilla de Quartus Il de una maquina de
estados de Moore de 4 estados:

(

) ;

// Quartus II Verilog HDL Template
// 4-State Moore state machine

// A Moore machine's outputs are dependent only on the

// current state.

// The output is written only when the state changes. (State
// transitions are synchronous.)

module four state moore state machine

input clk, in, reset,
output reg [1:0] out

// Declare state register
reg [1:0]state;

// Declare states
parameter SO = 0, S1 =1, S2 = 2, S3 = 3;

// Output depends only on the state
always @ (state) begin
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case (state)

S50:

out = 2'b01;
Sl:

out = 2'b10;
52

out = 2'bll;
S3:

out = 2'b00;
default:
out = 2'b00;
endcase
end

// Determine the next state
always @ (posedge clk or posedge reset) begin
if (reset)
state <= S0;

else
case (state)
S0:
state <= S1;
Sl:
if (in)
state <= S2;
else
state <= 351;
S2:
if (in)
state <= S3;
else
state <= 31;
S3:
if (in)
state <= S2;
else
state <= S3;
endcase
end
endmodule

Figura 4.1. Plantilla de Quartus Il de una maquina de Moore de 4 estados.

4.3 Estructura de la practica
Las practicas de este tema estan estructuradas de la siguiente forma:

1. Disefio en Verilog HDL de una maquina de estados finitos para el control de un
motor paso a paso.

2. Verificacion del funcionamiento de la maquina en un entorno de verificacion
predisefiado.

3. Disefo en Verilog HDL de una maquina de estados finitos para el disefio del
juego de luces del coche fantastico.
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4.4 Desarrollo de la practica

441 Tarea 2.1 - Diseiio de un controlador para un motor paso a paso

Se desea realizar un controlador para un motor paso a paso, mediante descripcion
Verilog HDL. El controlador que se debe implementar, tendrd que emular el
comportamiento del circuito integrado L297 de SGS THOMSON. Por tanto, el
controlador consistird en una maquina de ocho estados, en la que cada estado
determinard la situacion en la que se encuentra el bobinado del motor. La evolucion de
la maquina a través de los diferentes estados, provocara el giro del motor, cada
cambio de estado se interpreta como un paso. El controlador tendra cinco lineas de
entrada, cuyo comportamiento debera ser el siguiente:

CLK, linea de reloj, activa por flanco de subida.

RESET, asincrono y activo a nivel bajo, posiciona el controlador en el estado
inicial, también llamado “HOME”.

ENABLE, activa a nivel alto, habilita el funcionamiento del controlador; es
decir, mientras esté activa el controlador debe hacer girar el motor (ir
cambiando de estado).

UP_DOWN, esta linea sirve para indicar el sentido de giro del motor. Cuando
esta a nivel alto el motor gira en el sentido de las agujas del reloj, mientras que
a nivel bajo lo hace en sentido contrario.

HALF_FULL, esta linea permite configurar el modo de funcionamiento. Cuando
esta a nivel alto el motor esta en modo HALF, mientras que a nivel bajo el
motor se configura en modo NORMAL o WAVE.

El controlador debera tener asi mismo seis lineas de salida, denominadas A, B, C, D,
INH1 e INH2, cuyo comportamiento dependera del modo de funcionamiento tal y como
se detalla en la Figura 4.2, Figura 4.3 y Figura 4.4.
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Figura 4.2. Modo de funcionamiento "HALF".
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Figura 4.4. Modo de funcionamiento "WAVE".

Como se puede desprender de las figuras anteriores, en funcién de cémo evolucione
la maquina de estados, se tendran tres modos de funcionamiento. El modo "HALF" o
de medio paso en el que la maquina pasa secuencialmente por todos los estados. El
modo "NORMAL", en el que el controlador Gnicamente pasa por los estados impares.
Y por ultimo el modo "WAVE" en el que la evolucién se realiza a través de los estados
pares. En el modo de funcionamiento "HALF" el motor gira a medio paso, mientras que
en los otros dos lo hace a paso entero. La seleccion del modo de funcionamiento se
realiza por medio de la linea de entrada HALF_FULL, si la linea esta a nivel alto el
modo de funcionamiento es "HALF", sin embargo, si la linea se pone a nivel bajo el
modo de funcionamiento sera el "NORMAL" o el "WAVE" en funcién del estado en el
gue se encuentre.

Diseflar una maquina de estados en Verilog HDL que emule el funcionamiento del
controlador anteriormente descrito. ElI médulo disefiado debe denominarse
control motor, asi mismo deben respetarse los nombres de los puertos de entrada
y salida tal como se ha descrito anteriormente (Figura 4.5). Comprobar el correcto
funcionamiento de la maquina de estados mediante la simulacién de todas las posibles
opciones.
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module control motor

(
input CLK, RESET, UP DOWN, HALF FULL, ENABLE,
output reg A, B, C, D, INH1, INH2

)7

endmodule
Figura 4.5. Estructura del médulo Verilog HDL del controlador de motor.

4.4.2 Tarea 2.2 - Verificacion del controlador para motor paso a paso

La verificacion del funcionamiento del controlador para motor paso a paso, requiere de
un motor paso a paso. Sin embargo, la placa DE2 no dispone de dicho motor ni de la
electronica necesaria para conectar uno. Entonces ¢ Como verificar el funcionamiento
del controlador disefiado? Mediante un simulador de motor paso a paso realizado por

los profesores de la asignatura utilizando la placa DE2 y una pantalla tactil conectada
a ella.

TestBench

— DUT

control motor.v

CONTROL MOTOR
PASO A PASO

.
- :

SECOOOEELEENTR  § .I ! > : Control Velocidad Giro

m MR & AUTE. : [ -]

Figura 4.6. Estructura del simulador de motor paso a paso.
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En la Figura 4.6 se puede ver la estructura del simulador de motor paso a paso. Esta
constituido por un disefio de verificacion o TestBench, dentro del cual se englobara el
disefio bajo test (DUT), en este caso el controlador de motor paso a paso disefiado en
la tarea anterior. El TestBench se encargara de generar las sefiales de entrada al
DUT, recoger las sefiales de salida e interactuar con la placa DE2. En la pantalla tactil
conectada a la placa DE2 se mostraran puntos de colores alternativamente rojos y
verdes que describen una circunferencia y que representan el giro del motor paso a
paso. El simulador no solo utiliza la pantalla, sino que también emplea otros elementos
de la placa DE2, como los pulsadores, los interruptores, los LED y los displays 7-
segmentos. A continuacion se describe la funcionalidad de los distintos elementos de
la placa DE2:

Pulsador KEYO, es el RESET del sistema completo.

Interruptor SWO, linea ENABLE del controlador para motor paso a paso.
Interruptor SW1, linea HALF_FULL del controlador para motor paso a paso
Interruptor SW2, linea UP_DOWN del controlador para motor paso a paso

Los LEDGO a LEDGS, representan las sefiales A, B, C, D, INH1 e INH2
respectivamente del controlador para motor paso a paso.

Los LEDRO a LEDRI15, representan los 16 puntos o pasos en los que se ha
dividido una vuelta completa del motor en la representacion mostrada en la
pantalla.

El display HEXO, muestra el valor del estado de la maquina de estados que
implementa el controlador para motor paso a paso. Es una cifra entre el 1 y el
8, que se obtiene de modo inverso a partir de los valores de las sefales A, B,
C, D, INH1 e INH2, generados por el controlador teniendo en cuenta que se
ajustan a los diagramas de la Figura 4.2, Figura 4.3 y Figura 4.4.

El display HEX1, simplemente muestra la letra E de estado.

El display HEX3, muestra la velocidad de giro del motor. Un valor entre el 0 y el
9, donde la velocidad se duplica al incrementar el valor de tal forma que el 0
representa una velocidad de giro de un paso (o medio) por segundo y el 9 de
1,95 ms por paso (o medio paso).

La Pantalla Tactil:

o En el centro, se representa por medio de puntos que siguen una
trayectoria circular el giro del motor. En total se representan 16 puntos 8
rojos y 8 verdes alternados, con la finalidad de poder mostrar cuando
funciona a medio paso el motor o paso entero. Cuando el motor va a
medio paso se van viendo alternativamente puntos rojos y verdes.
Cuando el motor funciona a paso entero Unicamente se ven puntos
rojos o verdes en funcién del modo “normal” o “wave” del controlador.

o En la parte inferior, hay dos botones, representados por el signo mas
y el signo menos, que sirven para incrementar y decrementar
respectivamente, la velocidad de giro del motor.

El procedimiento para verificar el funcionamiento del controlador para motor paso a
paso utilizando el simulador realizado por los profesores de la asignatura serd el
siguiente:

1. Descargarse de PoliformaT el archivo motor alumno.qgar.
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2. Picando dos veces sobre el archivo anterior, se desempaqueta el proyecto de
Quartus Il que contiene el simulador. En el proceso de desempaquetado,
Quartus Il preguntard en qué lugar se quiere desempaquetar y si se quiere
abrir el proyecto.

3. Una vez abierto el proyecto se puede comprobar que hay un modulo Top
denominado Verifica motor, que en su interior instancia dos bloques el
testbench y el control motor. El primero esta oculto y el segundo no
existe, ya que es el disefio realizado en la tarea anterior.

4. Copiar el archivo control motor.v realizado en la tarea anterior en el
subdirectorio de trabajo donde este el proyecto de Quartus Il de verificacion
gque se acaba de desempaquetar.

5. Compilar de proyecto. Si se produce algun error sintictico debe ser debido a
incongruencias con los nombres de los puertos utilizados en el modulo
control motor o del propio nombre del moédulo. Realizar los cambios
pertinentes en el moédulo de control motor, nunca en el archivo de
verifica motor.

6. Una vez concluida la compilacién correctamente, hay que programar el
dispositivo de la placa DE2.

7. Probar el funcionamiento en la placa jugando con los diferentes botones y
computadores.

4.4.3 Tarea 2.3 - Disefio de una maquina de estados para el juego de luces del coche
fantastico

Ahora que se sabe cémo disefiar una maquina de estados finitos con Verilog HDL se

puede volver a plantear el ejercicio realizado en la Tarea 1.4, con un enfoque basado

en maquinas de estados finitos.

Diseflar una maquina de estados finitos que realice el juego de luces del coche
fantéstico al igual que se hizo en el disefio de la Tarea 1.4. Tal como se muestra en la
Figura 4.7, sigue haciendo falta el contador, para poder mantener la visualizacién de
los LEDs con una temporizaciéon de 0,25 segundos.

‘1'— UP/DOWN COUNT e
KEY[0]— RST_n KEY[0]— RST_n
CONTADOR FSM PROCESO DE
DECODIFICACION LEDG7
CLOCK_50— » CLK TC CLOCK_50 —> CLK ouT P
_‘ S DE LOS LEDS LEDGO
ENABLE ENABLE
SWO]

Figura 4.7. Diagrama de bloques de KIT, utilizando FSM.

Verifique su correcto funcionamiento en la placa DE2.
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5 Diseno de un Controlador para Pantalla Tactil

En este apartado se presenta un disefio puramente de control referido al manejo de
una pantalla tactil. En la que se podran distinguir dos partes bien diferenciadas, la
visualizacién con un control similar a la gestion de una VGA vy la captura del punto de
togue que consiste en una comunicacion serie. Conceptualmente el control de la
visualizacién o control VGA, no se va a plantear como una maquina de estados sino
como contadores interactuando entre si y decodificando convenientemente sus
salidas. Este tipo de disefios permitir4 disponer, de un sistema de visualizacion muy
potente de resultados de otros disefios. Igualmente el disefio de la captura del punto
de toque es una comunicacion serie y su subsiguiente conversion paralelo que es muy
comun en protocolos de comunicacion, con lo cual, se dispondrd de las ideas
fundamentales para transmisiones serie requeridas para algunos trabajos

5.1 Objetivos

e Aprender los conceptos basicos del leguaje Verilog HDL y su uso en el disefio
de control.

o Aprender el manejo de memorias ROM y mediante las macros disponibles en
Quartus Il.

e Aprender el método para probar el disefio en un hardware predisefiado,
completando la utilizacién de la placa educacional DE2 de Altera.

e Aprendizaje y uso de una pantalla tactil.

¢ Analizar el funcionamiento del teclado.

e Practicar con el envio de las sefiales del teclado

e Desarrollar un médulo interfaz teclado-pantalla.

e Desarrollar un modulo interfaz de comunicacién serie para convertidores
analégico-digitales.

e Potenciar la iniciativa e imaginacion en la realizacién de sistemas digitales.

5.2 Introducci6n teérica
Para entender como es posible generar una imagen de video usando la placa DE2 de
Altera, primero es necesario entender el funcionamiento de un monitor. Un monitor
VGA estandar consiste en una cuadricula de pixeles dividida en filas y columnas.
Normalmente un monitor VGA contiene 480 filas, con 640 pixeles por fila, tal y como
se muestra en la Figura 5.1.
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l¢q—— 640 pixels P
(0.0)

480
pixels

(640, 480)

Figura 5.1. Estructura de un monitor.

El color de cada pixel est4 determinado por el valor de las sefiales RGB (Red, Green,
Blue). Dependiendo del valor de estas sefales se obtiene un color diferente para el
pixel (ver Figura 5.2).

Figura 5.2. Configuracion del color.

Cada monitor VGA tiene un reloj interno que determina cuando cada pixel se actualiza
(o refresca). Este reloj suele operar a 25 MHz, para una resolucion de 640x480
pixeles.

El monitor refresca la pantalla de forma que es parcialmente controlada por las
sefales de sincronismo vertical y horizontal. EI monitor empieza cada ciclo de refresco
actualizando el pixel en la esquina superior izquierda de la pantalla, que puede
tomarse como el origen de un plano X-Y, tal y como muestra la Figura 5.1, como punto
(0,0). Después de que el primer pixel se refresca, el monitor refresca los siguientes
pixeles de la fila. Cuando el monitor recibe un pulso en la sincronizacion horizontal,
éste cambia de fila para refresca la siguiente fila de pixeles. Este proceso se repite
hasta que el monitor llega a la parte inferior de la pantalla. Cuando el monitor alcanza
la parte inferior de la pantalla, recibe un pulso a la sincronizacion vertical, causando
gue el monitor empiece a refrescar pixeles en la parte superior de la pantalla.



En un formato estdndar de VGA, la pantalla contiene 640x480 pixeles. La sefial de
video debe redibujar toda la pantalla 60 veces por segundo para dar una imagen fija y
reducir el flicker. Este periodo se llama el periodo de refresco. El ojo humano puede
detectar flicker con ciclos de refresco de menos de 30 Hz.

¢Por qué la VGA trabaja a 25MHz?

El periodo de refresco de la pantalla es de 60 Hz, por lo que cada pixel se
refrescard cada 40 ns; entonces es necesario un reloj de 25 MHz. En realidad
es mas ajustado 25,2 MHz ya que se tiene: 60 frames x 800 columnas x 525
filas = 25200000 pixeles

Hay que tener en cuenta que para que la pantalla VGA trabaje apropiadamente, debe
recibir los datos en unos instantes determinados mediante pulsos adecuados. En el
caso de los pulsos de sincronizacion vertical y horizontal deben producirse en unos
instantes especificos para sincronizar el monitor mientras va recibiendo los datos de
los colores.

Resumen funcionamiento VGA

El monitor escribe en la pantalla enviando las sefiales del color RGB (rojo,
verde, azul) y las sefales de sincronizacion horizontal y vertical cuando la
pantalla esta en la localizacibn esperada. Una vez que las sefiales de
sincronizacidn son exactas, el monitor necesita mantener la pista de la actual
localizacién, por eso éste envia el color correcto para cada pixel.

5.3 Descripcion del hardware especifico

La empresa Terasic vende un modulo de pantalla tactil digital, adaptado para la
conexion directa con las placas de Altera DE2 y DE1. Dicho médulo conocido también
por las siglas LTM (LCD Touch Panel Module), se conecta a las placas mediante un
cable paralelo de 40 pines del tipo IDE, utilizando principalmente el conector de
expansion JP1 de la placa.
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OE2 & AGEM.

Figura 5.3. Aspecto final de la conexién entre el médulo LTM y la placa DE2.

El LTM esta formado principalmente por tres componentes:

Una pantalla LCD de color TD0O43MTEAL de la marca Toppoly, la cual dispone
de un interface paralelo para visualizacién de imagenes con soporte RGB de
24 bits, y otro interface serie de tres lineas para el control de la visualizacién y
realizacion de ajustes, como el contraste, el brillo o la modulacién gamma entre
otros. En la Tabla 5.1 se pueden ver algunas especificaciones generales de la
pantalla:

Tabla 5.1. Caracteristicas generales de la pantalla.

item Descripcién Unidades
Tamafio de la Pantalla (Diagonal) 4,3 Pulgadas
Relacién de Aspecto 15:9 -
Tipo de Pantalla Retro iluminado (Backlight) -
Area Activa (H x V) 93,6 x 56,16 mm
Numero de Puntos (H x V) 800 x RGB x 480 Puntos
Tamafio del Punto (H x V) 0,039 x 0,117 mm
Distribucion de los Colores En Rayas (stripe) -
Numero de Colores 16 Millones -

Un convertidor Analdgico Digital AD7843 de Analog Devices, que se encarga
de convertir las coordenadas X e Y del punto donde se ha tocado la pantalla,
en datos digitales.

El conector de expansion de 40 pines.



Interface Serie

Sefiales RGB de Datos y
de Sincronismo Temporal

PANTALLA
LCD

Al Conector de
Expansion de la

Placa DE2/DE1
CONECTOR

EXPANSION

40 PINES

Interface Serie

Sefiales Analdgicas
de las Coordenadas

CONVERTIDOR

ADC

Figura 5.4. Diagrama de bloques del LTM.
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Figura 5.5. Detalle del patillaje en el conector de expansion de 40 pines.
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Tabla 5.2. Descripcion de las sefiales en el conector de expansién de 40 pines.

NUmero

de Pin Direccion Descripcion

1 ADC_PENIRQ n Output Peticion de interrupcion del ADC

2 ADC_DOUT Output Datos de salida serie del ADC

3 ADC BUSY Output Interface serie ADC ocupado

4 ADC_DIN Input Datos de entrada serie del ADC

5 ADC DCLK Input Reloj del interface serie del ADCy LCD

6 B3 Input Bit 3 azul bus de datos del LCD

7 B2 Input Bit 2 azul bus de datos del LCD

8 Bl Input Bit 1 azul bus de datos del LCD

9 BO Input Bit 0 azul bus de datos del LCD

10 NCLK Input Sefial de reloj del LCD

11 N/A

12 N/A

13 DEN Input fce:gal de habilitacion de los datos del

14 HD Input Sefal de sincronismo horizontal del LCD

15 VD Input Sefial de sincronismo vertical del LCD

16 B4 Input Bit 4 azul bus de datos del LCD

17 B5 Input Bit 5 azul bus de datos del LCD

18 B6 Input Bit 6 azul bus de datos del LCD

19 B7 Input Bit 7 azul bus de datos del LCD

20 GO Input Bit 0 verde bus de datos del LCD

21 G1 Input Bit 1 verde bus de datos del LCD

22 G2 Input Bit 2 verde bus de datos del LCD

23 G3 Input Bit 3 verde bus de datos del LCD

24 G4 Input Bit 4 verde bus de datos del LCD

25 G5 Input Bit 5 verde bus de datos del LCD

26 G6 Input Bit 6 verde bus de datos del LCD

27 G7 Input Bit 7 verde bus de datos del LCD

28 RO Input Bit O rojo bus de datos del LCD

29 N/A

30 N/A

31 R1 Input Bit 1 rojo bus de datos del LCD

32 R2 Input Bit 2 rojo bus de datos del LCD

33 R3 Input Bit 3 rojo bus de datos del LCD

34 R4 Input Bit 4 rojo bus de datos del LCD

35 R5 Input Bit 5 rojo bus de datos del LCD

36 R6 Input Bit 6 rojo bus de datos del LCD

37 R7 Input Bit 7 rojo bus de datos del LCD

38 GREST Input Reset global, activo a nivel bajo
Sefial de habilitacion del interface serie

39 SCEN Input del LCD a nivel alto y del ADC a nivel
bajo

40 SDA Input/Output Datos del interface serie del LCD




5.4 Utilizacién del Médulo LTM

En este apartado se muestra como se utiliza el médulo LTM, incluyendo el interface de
control serie de la pantalla LCD y el del convertidor analdgico-digital. También, se
mostraran los requerimientos temporales de las sefiales de sincronismo y de los datos
RGB de la pantalla LCD, necesarios para la representacion de imagenes en la misma.

5.4.1 Elinterface serie de la pantalla LCD

La pantalla LCD del médulo LTM dispone de un controlador de LCD que soporta tres
resoluciones de visualizacién de la pantalla y diferentes funciones de ajuste de la
imagen, ademas de disponer de un interface serie de comunicacion, un gestor de
temporizacion y un circuito de alimentacion. Todas las funciones que tiene el
controlador LCD se pueden gestionar accediendo a sus registros internos, por ejemplo
desde una FPGA, mediante el interface serie de la pantalla LCD.

El mdédulo LTM dispone también de un convertidor analégico-digital (ADC), que
permite obtener las coordenadas X e Y del punto donde se ha tocado la pantalla, por
medio de otro interface serie que tiene el convertidor ADC. Tanto, el interface serie de
la pantalla LCD como el del convertidor ADC se encuentran conectados a la FPGA de
la placa DE2 por medio del conector de 40 pines que disponen tanto la placa DE2
como el médulo LTM. Debido a la limitacidn de pines que impone el conector, se han
tenido que compartir algunas sefiales entre los interfaces serie de la pantalla LCD y
del convertidor ADC. Ambos interfaces serie utilizan la misma sefial de relgj
(ADC_DCLK) y la misma sefal de habilitacion (SCEN). Para evitar que la
comunicacion serie de un dispositivo pueda interferir con la del otro, la sefial de
habilitacién se ha negado por medio de un inversor en el convertidor ADC, tal como se
muestra en la Figura 5.6. Asi cuando la pantalla LCD se encuentra habilitada (SCEN a
nivel bajo) el convertidor ADC se encuentra deshabilitado y viceversa.
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Conector
Expansién 40 Pines Pantalla LCD

SDA = - SDA
ADC_DCLK o—p SCL
SCEN o | SCEN

Convertidor ADC

DCLK
>
ADC_DIN p DIN
ADC_DOUT |- DOUT
ADC_BUSY | BUSY
ADC_PENIRQ n |- PENIRQ

Figura 5.6. Esquema de conexionado de los interfaces serie de la pantalla LCD y del convertidor
ADC.

El interface serie de la pantalla LCD, consiste en una comunicacion serie sincrona en
la que la FPGA actua de master de la comunicacion generando las sefales adecuadas
y enviando los comandos de configuracion que se requieren. Mientras se esté
utilizando el interface serie es necesario que se mantenga la sefial de reloj NCLK de la
pantalla LCD. En la Figura 5.7 se muestra el diagrama temporal del funcionamiento del
interface serie, mientras que en la Tabla 5.3 se pueden obtener los valores
temporales. La pantalla LCD reconoce que comienza una nueva transmisién cuando
se produce un flanco de bajada de la sefial SCEN. A partir de ese momento en cada
flanco de subida de la sefial de reloj ADC_DCLK se captura un bit de la linea de datos
SDA.

Los primeros 6 bits (A5 ~ A0) indican la direccion del registro interno del controlador de
la pantalla LCD. A continuacion, hay un bit de Lectura/Escritura, un ‘0’ indica que se va
a escribir un dato en el registro y un ‘1’ que el dato del registro indicado se leera. El
siguiente ciclo es un paso de ciclo y seguidamente viene los 8 bits de datos (D7 ~ DO).
Los datos y las direcciones se envian secuencialmente desde el bit mas significativo al
menos significativo. El dato se escribird en la direccion indicada cuando se detecte el
final de la transferencia; es decir, después de los 16 ciclos de la sefal de reloj
ADC_DCLK. Los datos no seran aceptados si hay mas o menos de 16 flancos de
subida, en una transaccion.



@@@@@@@@@@@@@@ (sKa4)
= =

SCEN

Figura 5.7. Formato de la transmision y diagrama de temporizacion para el interface serie con la
pantalla LCD.

Tabla 5.3. Parametros temporales del interface serie con la pantalla LCD.

Simbolo Condiciones Min. Max. Unidades

. tso SCEN a SCL 150 ns
Tiempo Setup SDA t SDA a SCL 150 ns
. tho SCEN a SCL 150 ns
UiifpdlalelehIRT g SDA a SCL 150 ns
twiL Ancho pulso SCL 160 ns

Ancho de Pulso twin Ancho pulso SCL 160 ns
two Ancho pulso SCEN 1,0 ns

Ciclo de Trabajo 40 60 %

5.4.2 Temporizacion de las senales para la visualizacion en la pantalla LCD

Para realizar la visualizacion de imagenes en la pantalla del LCD, hay que generar las
sefales de sincronismo y de datos adecuadas desde la FPGA al modulo LTM, para lo
cual es necesario conocer las especificaciones temporales del mismo. Las sefales de
datos y sincronismo que necesita la pantalla LCD para visualizar imagenes son los
estandares para monitores VGA. Los datos tienen formato RGB, utilizando 8 bits en
paralelo para representar cada uno de los colores: Rojo (R[7..0]), Verde (G[7..0]) y
Azul (B[7..0]), mas una linea de habilitacion de los datos (DEN). Para el sincronismo
es necesaria una linea de reloj (NCLK), acompafiada por las tipicas sefiales de
sincronismo horizontal (HD) y vertical (VD).

En la Figura 5.8 se muestran los requerimientos temporales basicos para la
visualizacién de cada fila (horizontal) que se quiere mostrar en la pantalla LCD. Un
pulso activo a nivel bajo de duracion concreta (tn,w), Se utiliza como sefial de
sincronismo horizontal (HD), para indicar el final de una linea y el comienzo de una
nueva linea de datos. Después del pulso de sincronismo horizontal, las entradas de
datos (RGB), todavia no son validas durante un periodo de tiempo conocido como
“back porch” (th,p). Tras este tiempo, vendra el tiempo de visualizacion de los datos en
pantalla (t,4), en el que los datos se aplican a los pixeles, mediante un recorrido
horizontal por la fila seleccionada. Durante el tiempo de visualizacién de los datos en
la pantalla (t,g), la sefial de habilitacion de la pantalla LCD (DEN) debe permanecer a
nivel alto. Finalmente hay un nuevo periodo temporal denominado “front porch” (tn),
en el que las entradas de datos (RGB) vuelven a no ser validos, y que tras concluir se
produce un nuevo pulso de sincronismo horizontal.
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thpw—> |-
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RO ~ R7
GO ~ G7 Datos Validos
BO ~ B7
Area Visualizacion
thop | tha | thip R
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Figura 5.8. Diagrama de la temporizacién horizontal de la pantalla LCD.

La temporizacién del sincronismo vertical (VD), es similar a la anterior, tal como se
muestra en la Figura 5.9, a excepcidn que un pulso de sincronismo vertical significa
que ha terminado un “frame” o refresco completo de la pantalla y comienza el
siguiente. Ademas, los datos se refieren al conjunto de todas las filas de un “frame”. La
Tabla 5.4 y la Tabla 5.5 muestran los distintos valores temporales de la temporizacion
horizontal y vertical para las diferentes resoluciones soportadas por la pantalla LCD.
Finalmente la Tabla 5.6 muestra los valores temporales de las sefiales de sincronismo
horizontal y vertical.

Tabla 5.4. Parametros temporales horizontales de la pantalla LCD.

Resolucion

B00XRGEx480 | 480xRGBx272 | 400xRGBx240 U"103d€S

Parametro Simbolo

lr:erﬁa?uenda e NCLK 33,2 9 8,3 MHz

aﬁﬁ)zsc)ntales tha 800 480 400 NCLK

Horizontal th 1056 525 528 NCLK
Min. 1

Puiso HS | 1P| ton - NCLK
Max. -

nonzontal Back | g 216 43 108 NCLK

norizontal Front |t 40 2 20 NCLK

Habitacion DEN | 800 480 400 NCLK
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Figura 5.9. Diagrama de la temporizacién vertical de la pantalla LCD.

Tabla 5.5. Parametros temporales verticales de la pantalla LCD.

Resolucién

SEEEe Simbolo 800xRGBx480 | 480xRGBx272 | 400xRGBx240 Unidades
Datos Verticales tvg 480 272 240 H
\T/gtrﬁ'c';f”"do £, 525 286 262 H
Ancho de _I\I{:m. i E H
Pulso VS P vpw

Max. -

pertioal “Back tunp 35 12 20 H
Vertical “Front

Porch” Ll 10 2 2 H
Vertical

ublanklngu tvb 45 14 22 H
Tiempo

Habilitacion DEN |  [EN 480 212 240 H
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Tabla 5.6. Parametros temporales de las sefiales de sincronizaciéon de la pantalla LCD.

Parametro Simbolo in. Unidades
Periodo NCLK PW ¢k 25 ns
Ancho de pulso a nivel
alto NCLK PWH-, 10 ns
Ancho de pulso a nivel
bajo NCLK PWL~ 10 ns
Tiempo de setup de los t 5 ns
datos, HD, VD y DEN ds
Tiempo de hold de los i 5 ns
datos, HD, VD y DEN dn

5.4.3 Elinterface serie del convertidor ADC

El médulo LTM se encuentra equipado con el circuito integrado de Analog Devices
AD7843, para el uso de pantallas tactiles. El AD7843 es un convertidor ADC de 12
bits, que proporciona la posicion X e Y del punto de contacto que se ha tocado en la
pantalla. La informacion de las coordenadas X e Y del punto de contacto, capturadas
por el convertidor AD7843 se pueden obtener por medio del interface serie que
dispone dicho convertidor.

Para obtener las coordenadas del convertidor ADC, en primer lugar hay que
monitorizar la sefal de interrupcion ADC_PENIRQ n. Esta sefial permanece
normalmente a nivel alto. Cuando se toca la pantalla por medio de un lapiz o del dedo,
la sefial ADC_PENIRQ n pasa a nivel bajo. En consecuencia, la sefal
ADC_PENIRQ_n se puede utilizar para inicial o desencadenar, desde una FPGA, un
proceso que generé la palabra de control necesaria para obtener del convertidor ADC
las coordenadas X e Y del punto de la pantalla LCD que ha sido tocado.

La palabra de control que se debe enviar al convertidor ADC, por medio de la linea de
datos ADC DIN de su interface serie, se muestra en la Tabla 5.7. En ella se
proporciona la informacion sobre el comienzo de la conversién, el canal a direccionar,
la resolucion de la conversion, la configuracion y el modo de alimentacion del
convertidor ADC.

En la Figura 5.10 se muestra una operacion tipica, por medio del interface serie del
convertidor ADC. El reloj serie ADC_DCLK es el encargado de gestionar todo el
proceso de transferencia de informacién hacia y desde el convertidor ADC. Una
conversién de datos completa dura 24 ciclos de reloj. Recordar que la linea de
habilitacion SCEN se encuentra compartida con el interface serie de control de la
pantalla LCD.



Tabla 5.7. Descripcion del funcionamiento de los bits del registro de configuracién del AD7843.

S A2 Al A0 MODE | SER/DEF PD1 PDO

Nemotécnico Comentario

Bit de Comienzo. La palabra de control comienza con
un bit a nivel alto en la linea de datos ADC_DIN. Cada
15 ciclos de reloj (ADC_DCLK), puede comenzar una
7 S nueva palabra de control para el modo de
funcionamiento de 12 bits de conversion, mientras que
en el modo de conversion con 8 bits puede empezar
cada 11 ciclos de reloj.

Bits de Seleccion del Canal. Estos tres bits de

direccién, junto con el bit SER/DEF, controlan la
selecciéon de las sefales de entrada que se van a
utilizar para la conversion.

Control de resolucién. Este bit permite seleccionar si la
3 MODE conversion analdgico digital se realiza utilizando 12 bits
(cero l6gico) u 8 bits (uno l6gico).

Este bit permite seleccionar entre entrada simple o
2 SER/DEF diferencial. Funciona en conjuncién con las lineas de
seleccion del canal A2-A0.

Bits de control de alimentacion. Estos dos bits permiten

6-4 A2-A0

1,0 PD1, PDO seleccionar el modo de consumo del convertidor
AD7843.
ADC_PENIRQ_n

SCEN I_

ADC_DCLK 1 8 1 8 1 8

ADC_DIN [ s Tae ] w J no Jwooe] 3o [reor [ poo |
Start Espera | Adquisicion | Conversion Espera
ADC_BUSY Triestado | '—l Tnelsﬂ
T d Coordenada X o Y . ’

ADC_DOUT —et&e [G]w] o es] 7165 @ [ 3] 2]1t]0] relenatoconceos e

MSB LSB

Figura 5.10. Diagrama de la temporizacion de la conversion en el interface serie del convertidor
ADC.

5.5 Estructura de la practica
Las practicas de este apartado estan estructuradas de la siguiente forma:

1. Disefio de un sistema que genere sefiales de video para el control de la
visualizacién de la pantalla tactil.
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2. Realizacion de ejercicios sobre el disefio realizado anteriormente para su
comprobacion.
a. Disefio para cambiar el color de la pantalla.
b. Disefio para que aparezcan en pantalla rayas de diferentes colores en
la pantalla.
c. Disefio para que dada una posicion determinada colocar una letra o
figura.
Disefio de un sistema de comunicacion del teclado con la pantalla.
4. Disefo de un sistema de comunicacion serie con un ADC, para la gestién de la
parte tactil de la pantalla.
5. Disefio libre de un sistema digital donde se fusionen la visualizacién en la
pantalla y el uso de la funcion tactil.
6. Verificacion de los modulos anteriores mediante la configuracién de la FPGA
Cyclone Il de la placa DE2.

w

5.6 Desarrollo de la practica

En este apartado se pretende plantear el disefio hardware en una FPGA de un bloque
que permita utilizar el modulo LTM en la placa DE2 de Altera. Aunque inicialmente
puede parecer una labor ardua, con una adecuada estructuracion de las tareas a
realizar terminara convirtiéndose en un reto personal de resultados altamente
satisfactorios, para los amantes de la electronica digital.

Tal como se describe en la introduccion del capitulo y se ve reflejado en la Figura 5.4,
el modulo LTM estd formado bésicamente por dos bloques: La pantalla LCD vy el
convertidor ADC. La pantalla LCD se puede descomponer a su vez en dos elementos,
el interface serie de la pantalla y las sefiales de datos y sincronismo. Por tanto, a la
hora de realizar el disefio del bloque de control del médulo LTM, se planteara como la
realizacion de tres bloques de disefio: El interface serie de la pantalla LCD, la
generacion de las sefiales de sincronismo y datos de la pantalla LCD y el interface
serie del convertidor ADC.

5.6.1 Tarea 3.1 — Generacion de las senales de sincronismo y datos de la pantalla LCD
En primer lugar se aborda el disefio del bloque encargado de generar las sefales de
datos y sincronismo de la pantalla LCD. Este bloque permitira la representacion de
iméagenes en la pantalla. Es importante destacar que la configuracion inicial de la
pantalla permite la visualizacion de imagenes con una resolucion de 800x480 pixeles;
lo cual significa que no es necesario realizar el disefio del interface serie de la pantalla,
para poder ver imagenes en la pantalla. El interface serie de la pantalla s6lo hace falta
en el caso de querer cambiar la resoluciéon de la pantalla u otros parametros de
configuracion o de la visualizacion de la misma.

Se quiere disefiar el médulo que genere las sefales de sincronismo de la pantalla
LCD. Tal como se observa en la Figura 5.11, este moédulo tendrd las siguientes
sefales de entrada y salida:

e Sefales de entrada:

o CLK, sefial de reloj.

o RST_N. reset activo a nivel bajo.
e Sefiales de salida:



HD y VD, sefiales de sincronismo horizontal y vertical respectivamente.
GREST, reset global de la pantalla.

NCLK, sefial de reloj de salida hacia la pantalla.

DEN, sefial de habilitacion de la visualizacién en la pantalla.

Fila y Columna, salidas que indican la posicion en la que se encuentra
el refresco de la pantalla.

0 O O O O

Para generar las sefiales de sincronismo, teniendo en cuenta que la resolucion es
800x480 pixeles, se utilizaran contadores de forma que ajusten a lo representado en la
Figura 5.8 y en la Tabla 5.4 para el sincronismo horizontal y en la Figura 5.9 y en la
Tabla 5.5 para el sincronismo vertical. Por tanto para generar el sincronismo
horizontal, simplemente hace falta un contador que cuente 800 ciclos de la sefial de
reloj NCLK. Mientras que para generar el sincronismo vertical, el contador debe contar
480 ciclos del sincronismo horizontal.

LCD_SYNC
—{CLK NCLK —»
—» RST_n GREST —»
HD —»
VD —»
DEN —»
Fila Columna

¢ ¢

Figura 5.11. Esquema de entradas y salidas del bloque de generacién de datos y sincronismo de la
pantalla LCD.

Las sefiales de sincronismo y de color seran registradas a su salida ya que un
pequefio retraso de unos pocos nanosegundos genera que las sefiales de color RGB
provoguen una imagen borrosa.

Es importante tener en cuenta que la sefial DEN de salida solo debe de estar activa en
la region visible (800x480) de la pantalla. En caso contrario no se observara nada en
la pantalla.

También hay que hacer notar la existencia de una sefial denominada GREST, cuya
funcion es realizar un Reset del médulo LTM, debiendo permanecer a nivel alto
cuando se quiere hacer funcionar el médulo.

Es relevante destacar que aunque la sefial de reloj NCLK, se establezca en 33,2 MHz
en la Tabla 5.4, las especificaciones de la pantalla acepta frecuencias hasta 40 MHz,
siendo perfectamente valida la opcion de utilizar una sefial de 25 MHz, al igual que la
de una VGA, manteniendo en este caso los mismo valores de conteo que se
especifican en la Tabla 5.4 y en la Tabla 5.5. En este caso lo mas adecuado es que
todo el disefio funcione con una sefial de reloj de 25 MHz, en lugar de los 50 MHz del
oscilador de la placa DE2.
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¢,Como se pueden obtener los 25 MHz, teniendo en cuenta que el oscilador
externo es de 50 MHz y hay que mantener los criterios del correcto disefo
sincrono? La respuesta es: mediante un PLL de los que disponen internamente las
FPGAs. Este elemento permite generar un reloj, de distinta frecuencia y fase, a partir
de otro. Los PLLs internos del dispositivo se pueden utilizar generandolos y
caracterizandolos mediante la herramienta MegaWizard Plug-In Manager de Quartus
Il. EI MegaWizard Plug-In Manager dispone de una funcién denominada ALTPLL que
permite crea un nuevo modulo con los pardmetros adecuados para utilizar las PLL
internas de la FPGA. Por medio de las diferentes ventanas de configuracion de la
funcién ALTPLL se establecen las caracteristicas del PLL que se quiere utilizar. Dicha
funcion genera los archivos necesarios para utilizar el PLL, entre ellos una plantilla
para la instanciacion del mismo en el disefio donde se vaya a utilizar. En la Figura 5.12
se muestra el codigo Verilog HDL, para instanciar y utilizar un PLL llamado pl11 25,
generado mediante la funciéon ALTPLL del MegaWizard Plug-In Manager de Quartus
Il.

pll 25 pll 25 inst (
.inclk0 ( inclkO _sig ),
.cO0 ( cO0_sig )
) 7

Figura 5.12. Ejemplo de instanciacién de un PLL generado con el MegaWizard Plug-In Manager.

Una vez realizado el disefio en Verilog HDL del médulo LCD_SYNC, hay que verificar
su funcionamiento mediante las correspondientes simulaciones. Dadas las
caracteristicas del disefio, se requiere de tiempos de simulacibn mayores de los
empleados hasta este momento. Por ello, es necesario emplear un simulador mas
profesional como es el ModelSim-Altera.

Realizar la verificacion del funcionamiento del mddulo LCD SYNC, mediante
simulaciones utilizando el simulador ModelSim-Altera, tal como se explica en el
apartado 2.3 (Uso del WaveForm de Quartus como generador de Testbench para
Modelsim-Altera) de la pagina 20.

5.6.2 Tarea 3.2 — Cambio de color de la pantalla

Tras disefiar el médulo anterior ahora se requiere verificar su funcionamiento en la
placa DE2. En este apartado Unicamente se requiere utilizar el médulo LCD_SYNC y
asignar un valor a las sefiales correspondientes de los colores (RGB), para que en la
pantalla se vea uniformemente un color, en funcion del valor de las sefiales RGB. En
la Figura 5.13 se muestra un esquema de bloques de lo que se pretende realizar.



Tabla 5.8. Descripcion de las sefiales del médulo LTM en relacion con la asignacion de pines en la
FPGA de la placa DE2.

Asignacién

EPGA Nombre Direccion Descripcion
D25 ADC PENIRQ n Input Peticion de interrupcién del ADC
J22 ADC_DOUT Input Datos de salida serie del ADC
E26 ADC_BUSY Input Interface serie ADC ocupado
E25 ADC DIN Output Datos de entrada serie del ADC
F24 ADC_DCLK Output ﬁg:gj del interface serie del ADC y
F23 B3 Output Bit 3 azul bus de datos del LCD
J21 B2 Output Bit 2 azul bus de datos del LCD
J20 Bl Output Bit 1 azul bus de datos del LCD
F25 BO Output Bit 0 azul bus de datos del LCD
F26 NCLK Output Sefal de reloj del LCD
N18 DEN Output Ece:rgal de habilitacion de los datos del
P18 HD Output Ece:r”[;al de sincronismo horizontal del
G23 VD Output Sefal de sincronismo vertical del LCD
G24 B4 Output Bit 4 azul bus de datos del LCD
K22 B5 Output Bit 5 azul bus de datos del LCD
G25 B6 Output Bit 6 azul bus de datos del LCD
H23 B7 Output Bit 7 azul bus de datos del LCD
H24 GO Output Bit O verde bus de datos del LCD
J23 Gl Output Bit 1 verde bus de datos del LCD
J24 G2 Output Bit 2 verde bus de datos del LCD
H25 G3 Output Bit 3 verde bus de datos del LCD
H26 G4 Output Bit 4 verde bus de datos del LCD
H19 G5 Output Bit 5 verde bus de datos del LCD
K18 G6 Output Bit 6 verde bus de datos del LCD
K19 G7 Output Bit 7 verde bus de datos del LCD
K21 RO Output Bit O rojo bus de datos del LCD
K23 R1 Output Bit 1 rojo bus de datos del LCD
K24 R2 Output Bit 2 rojo bus de datos del LCD
L21 R3 Output Bit 3 rojo bus de datos del LCD
L20 R4 Output Bit 4 rojo bus de datos del LCD
J25 R5 Output Bit 5 rojo bus de datos del LCD
J26 R6 Output Bit 6 rojo bus de datos del LCD
L23 R7 Output Bit 7 rojo bus de datos del LCD
L24 GREST Output Reset global, activo a nivel bajo
Sefial de habilitacion del interface
L25 SCEN Output serie del LCD a nivel alto y del ADC a
nivel bajo
L19 SDA Input/Output  Datos del interface serie del LCD
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COLOR_LCD

LCD_SYNC

—1—»{ CLK NCLK >
—+—»| RST_n GREST >
HD >
VD >
DEN >

Fila Columna

1!

R[7..0] >
G[7..0] | >
B[7..0] | >

Figura 5.13. Esquema de entradas y salidas del bloque que permite visualizar un color en la
pantalla LCD.

En la Tabla 5.8, se puede ver la asignacion de pines que debe realizarse a las sefales
de la FPGA de la placa DE2, para utilizar el médulo LTM conectado al conector JP1.

Importante destacar que la pantalla se encuentra fisicamente atornillada a la placa con
una rotacién de 90°, tal como se aprecia en la Figura 5.3. Esto significa que aunque la
resolucion sea de 800 pixeles en horizontal y 480 pixeles en vertical, hay que tener en
cuenta que fisicamente esta girada esos 90°.

5.6.3 Tarea 3.3 — Generacion de barras de colores en la pantalla

En este apartado las imagenes que se quieren obtener en pantalla son barras
verticales u horizontales de diferentes colores. Para ello habra que ‘jugar’ con las
diferentes sefiales RGB que forman el médulo COLOR_LCD, en funcién del valor de la
fila'y la columna.

5.6.4 Tarea 3.4 — Visualizacion de caracteres en pantalla

En este apartado se quiere poder visualizar en pantalla caracteres (por ejemplo: 0, A,
B...). La pantalla esta constantemente actualizdndose (refrescandose), por ello es
necesario el uso de una memoria para mantener los caracteres y que puedan ser
mostrados en pantalla. Para ello se realizara el disefio de un médulo que vaya leyendo
de memoria cada caracter y que vaya actuando adecuadamente sobre la sefiales RGB
en funcién de los valores de Fila y Columna proporcionados por el modulo
LCD_SYNC, para sacar el caracter por pantalla.

La memoria a utilizar en el disefio serd una memoria interna del dispositivo. Estas
memoarias se pueden crear mediante la herramienta MegaWizard Plug-In Manager de



Quartus I, la cual dispone de un compilador de memorias que permite generar
memoarias de varios tipos como una ROM, gque hace falta en este caso.

Esta memoria guardard los caracteres que se quieran visualizar en pantalla. Estos
caracteres serdn de dimension 8x8. La ROM habra que inicializarla con estos
caracteres, para ello se utilizara un archivo tipo MIF.

El archivo MIF (Memory Initialization File) se utiliza para inicializar la memoria. El
archivo puede definirse usando sefiales binarias, hexadecimales, decimales u octales.
El siguiente ejemplo define una memoria de 512 celdas con anchura de 8 bits. Las
direcciones son definidas en octal y los datos de las celdas en binario, para una mejor
comprension.

El patron [00000000 .. 11111111] : O; inicializa todas las celdas de la memoria
a 0 antes de dar valores a unas determinadas direcciones. De esta forma no es
necesario definir toda la memoria debido a que la primera asignacion que se hace es
poner a 0 todas las celdas.

Depth = 512;
wWidth = 8
Address radix = oct
Data radix=bin
% Instruction Pattern %
Content

Begin

[00000000 .. 11111111] =: O;

%% DATOS PARA LA MEMORIA%S

End;
Figura 5.14. Ejemplo de archivo MIF.

Cada letra, nUmero o simbolo es una imagen de 8x8 pixeles de forma que su
implementacién se realizara de la siguiente manera teniendo en cuenta que la primera
direccion de la memoria es 000001; por ejemplo, la implementacion de la letra A se
muestra en la Figura 5.15. Observar, que en el ejemplo, las direcciones que forman
parte del caracter. Para el caracter A la direcciéon es 01 y de 0 a 7 se va recorriendo
cada fila. Es por ello que para el 2° caracter (‘B’ p.e.) la direccion serd 02. De esta
forma direccionar el caracter se simplifica mucho.

$Direccidén Datos del caracter Caracter visualizado%
010 : 00011000 ; g * % o
011 00111100 ; S * k% % °
012 01100110 ; S *x o kx 5
013 : 01111110 ; T L
014 01100110 ; S *x o kx 5
015 : 01100110 ; S *x o kx 5
0le : 01100110 ; S *x o kx 5
017 : 00000000 ; 3 5

Figura 5.15. Ejemplo de implementacién de la letra A.

Tal y como se ha indicado anteriormente el médulo que se tiene que disefiar utilizara
una memoria ROM de forma que ird leyendo cada caracter y que vaya actuando
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adecuadamente sobre la sefiales RGB en funcion de los valores de Fila y Columna
proporcionados por el médulo LCD_SYNC, para sacar el caracter por pantalla.

Para poder ir leyendo cada caracter de la memoria se utilizara contadores de columna
y fila. El contador de columna se utiliza para seleccionar cada bit de izquierda a
derecha en cada letra de la memoria al igual que la sefial de video se mueve a lo largo
de cada fila. El valor leido serd 0 6 1, indicando un color diferente para cada valor.

Direccién —————
del
caracter —
ROM_mux_out
ROM MUX a LCD_SYNC
(senales de color)
Fila ——
-] ~
/
Columna

Figura 5.16. Esquema del disefio (CHAR_ROM) a realizar.

La Figura 5.16 muestra el modulo (CHAR_ROM) que hay que realizar. Como se
observa tiene las siguientes sefales externas:

Direccion del caracter, entrada que nos indica la direccion del caracter que se
quiere visualizar en pantalla. Como se ha explicado anteriormente sera 01, en
el caso del caracter A.

Fila, entrada que indica la fila que hay que leer en memoria, es decir, es el
contador de fila. Este contador no habra que implementarlo si no que se
utilizara el dado por el médulo LCD_SYNC que ya recorre las filas.

Columna, entrada que indica la columna que hay que leer en memoria, es
decir, es el contador columna, que también se obtendra de la salida del
moédulo LCD_SYNC. En nuestro caso se necesitan para los 8 datos a
multiplexar, tres sefiales del contador de columnas.

ROM_mux_output, salida que va dando los datos de cada columna para
pasérselo a la pantalla. Por ello se conectara a las entradas R, G, B del
LCD_SYNC. Se ha dibujado una sola salida porque seguramente se
manipulara Unicamente una de las tres sefiales RGB para dejar las otras dos
restantes fijas.

En dicho esquema, el moédulo ROM debera ser implementado mediante una memoria
interna ROM (como se habia indicado anteriormente) con un fichero de inicializacion
adecuado para representar hasta 64 caracteres diferentes (ver Figura 5.17). Dicho
fichero de inicializacion lo se encuentra disponible en PoliformaT.



Direccidn

Caracter Fuente 8 x 8
000001 para A ° R ROM pixeles
7 Generacion
Caracteres
Fila 64 Caracteres
000...111 , 512 x 8 bits

YA

8 x 8 bits por caracter

Figura 5.17. Organizacion de la memoria ROM.

Como se ha elegido un tamafio de caracter de 8x8 y la resolucion de la pantalla es de
800x480 pixeles, el numero maximo de caracteres que puede soportar el modulo sera
100x16.

Se quiere que toda la pantalla se llene de caracteres diferentes o iguales. Se quiere
obtener este tipo de representacion porque es mucho mas facil de implementar y
resultard mas facil de comprobar el médulo disefiado ya que no se tiene en cuenta la
posicion en pantalla sino que sélo se introduce informacion por las sefiales R, G, B.

5.6.5 Tarea 3.5 — Generacion de una figura simple en un punto determinado de la
pantalla

En este apartado se quiere que el caracter creado en el apartado anterior y que se ha

podido visualizar aparezca en pantalla una Unica vez y en una posicion determinada lo

mas centrada posible en pantalla.

5.6.6 Tarea 3.6 — Generaci6n de una frase que aparezca en pantalla

En este apartado se quiere visualizar los nombres de los componentes del grupo de
practicas en pantalla (en una linea bastante centrada). Cémo idea se debe partir del
esquema observado en la Figura 5.16 con la diferencia de que la direccién de caracter
no es una informacion fija sino que va a ser unas direcciones cambiantes segun el
posicionado en pantalla (controlado de nuevo por los contadores de filas y columnas).

Una sugerencia importante seria almacenar en otra memoria ROM la frase a visualizar
(los contenidos de esa memoria serian las direcciones a seleccionar en la
CHAR_ROM) y se direccionaria esa nueva memoria mediante los contadores de filas y
columnas que se tiene accesibles. El correcto direccionamiento y la correcta
generacion del archivo tipo MIF de inicializacion marcaran el éxito 0 no que se pueda
tener en este ejercicio.

5.6.7 Tarea 3.7 — Escribir desde el teclado y visualizar en pantalla
Tras realizar las practicas de la pantalla donde se manejaba ésta y se podian
visualizar caracteres en una posicion determinada, se quiere implementar un médulo
que se utilice para visualizar en la pantalla las teclas pulsadas en un teclado PS/2
conectado a la placa DE2, tal y como se muestra la Figura 5.18.
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Para que no haya que realizar el disefio de control del teclado, en PoliformaT se
encuentra disponible una version de dicho bloque, realizada por los profesores de la
asignatura. El médulo de control de teclado facilitado proporciona el valor de la tecla
pulsada en cada momento. Dicho dato en lo que se conoce como el “scan code” de la
tecla, el cual es Unico y universal para todos los teclados.

Modulo
TECLADO
Disefno para visualizar
? en la pantalla
caractéres
ROM
(scan code)

Figura 5.18. Idea del disefio a realizar.

Disefiar un médulo que visualice por pantalla en una posicién dada cada una de las
letras pulsadas en el teclado. Tal y como se muestra en la Figura 5.18 el disefio a
realizar serd la interfaz entre el médulo de teclado y el médulo utilizado para visualizar
caracteres. Por ello habra que realizar una transformacién del “scan code” a la ROM
de los caracteres. En la Figura 5.19 se muestra un esquema de cémo se puede hacer
dicha transformacion.

Médulo CHAR_ROM

Modulo TECLADO Mddulo a disefiar
1C
Direccion del
scan code 1C |:“> 01 ";?;,I:;re
> e P»| Direccion 01
Captura codigo Decodificar
tecla pulsada
En la ROM se obtiene A

—— )

Al pulsar una tecla

Figura 5.19. Esquema de la solucion a realizar.

Por ejemplo: si se pulsa la tecla ‘A’ del teclado, el cddigo que se transmite por la linea
0 “scan code” es “1C’. Cuando se reciba este codigo el mdédulo a implementar debe
actuar de decodificador y pasar este cédigo al codigo correspondiente a la letra A que



esta contenido en la archivo MIF del médulo CHAR_ROM, es decir se traducira por la
direccién 01, para recordarlo ver la Figura 5.15.

5.6.8 Tarea 4.1 — Interface serie del convertidor ADC

El interface serie del convertidor ADC, permite obtener las coordenadas X e Y del
punto de la pantalla que ha sido tocado por un dedo o por un lapiz. Para ello, hay que
realizar un bloque que establezca una comunicacion serie con el convertidor AD7843
de Analog Devices, ajustdndose a los requerimientos temporales y de funcionamiento
descritos en la Figura 5.10. El blogue de interface serie con el convertidor ADC, es un
disefio independiente del de la pantalla, con la salvedad que por restricciones de
conexion se comparten dos sefiales, tal como se muestra en la Figura 5.6: la sefial de
reloj ADC_DCLK y la de seleccién SCEN.

En este apartado se sentaran las bases para realizar el disefio del interface serie del
convertidor ADC, considerando su total independencia; es decir, que hay que generar
todas las sefiales necesarias para la comunicaciéon. En la Figura 5.20, se muestra el
diagrama del bloque objeto de disefio con las entradas y salidas que debe tener.
Ademas de las sefiales propias del interface serie para controlar el convertidor ADC,
se debe obtener como salida el valor de las coordenadas X e Y del punto de contacto,
que en definitiva es la finalidad del disefio.

ADC_CONTROL

— CLK ADC_DCLK
— RST_n SCEN
ADC_BUSY

ADC_PENIRQ n

ADC_DIN

REERE

ADC_DOUT

X_COORD  Y_COORD

¢ 9

Figura 5.20. Diagrama de entradas y salidas del interface serie del convertidor ADC.

Tal como se ha descrito anteriormente, cuando un dedo toca la pantalla del médulo
LTM, el convertidor ADC pasa a nivel bajo la sefial ADC_PENIRQ_n, momento que se
debe de utilizar para inicial la comunicacién con el convertidor ADC, con la finalidad de
obtener el valor de las coordenadas del punto que se ha tocado. Para ello, en primer
lugar, hay que enviar al convertidor ADC, por la linea ADC_DIN un byte de control
cuyo contenido se describe en la Tabla 5.7. Para obtener el valor concreto del byte, se
estableceran las siguientes consideraciones: conversion de 12 bits, modo de entrada
diferencial y con alimentacién activada y ADC_PENIRQ _n habilitada. A partir de estos
parametros se establecen los valores que debe tener el byte de control, segin se
quiera leer la coordenada X o la Y, tal como son mostrados en la Tabla 5.9.
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Tabla 5.9. Valores del byte de control en funcion de la coordenada.

MSB LSB

S A2 Al A0 MODE | SER/DEF | PD1 PDO
X 1 0 0 1 0 0 1 0
Y 1 1 0 1 0 0 1 0

El hecho que haya palabras de control distintas para obtener la coordenada X y la Y,
significa que hay que realizar dos operaciones de lectura del convertidor para
conseguir el valor exacto del punto de contacto. Por fortuna, el proceso de lectura en
ambos casos es idéntico al mostrado en la Figura 5.10, comienza con la puesta a nivel
bajo de la sefial ADC_PENIRQ n, tras lo cual se envia la palabra de control para la
lectura de la coordenada X o la Y, una vez recibido el dato, tras los 24 ciclos de la
sefial ADC_DCLK, concluye la comunicacion. Esto significa que tras obtener en primer
lugar la coordenada X, la sefial ADC_PENIRQ_n vuelve a nivel bajo iniciando un
nuevo proceso que permite la lectura de la coordenada Y. Todo esto es posible,
porque el dedo permanece mucho tiempo tocando la pantalla, en comparacién con el
tiempo de comunicacién, provocando asi que se puedan generar varios flancos
descendentes de la sefial ADC_PENIRQ_n, durante el tiempo de contacto.

Los datos de catalogo del convertidor AD7843, establecen que la frecuencia de la
sefial de reloj ADC_DCLK, que fija la velocidad de comunicacién, puede establecerse
en un valor minimo de 10 kHz hasta un valor méximo de 2 MHz.

Para facilitar la realizacion de esta tarea se ha desarrollado un entorno de verificacién
sobre Quartus basado en el uso del simulador ModelSim. Por tanto, el procedimiento
para realizar el disefio y verificacion del ADC_CONTROL solicitado sera el siguiente:

1. Descargarse de PoliformaT el archivo Touch alumno.gar.

2. Picando dos veces sobre el archivo anterior, se desempaqueta el proyecto de
Quartus Il. En el proceso de desempaquetado, Quartus |l preguntard en qué
lugar se quiere desempaquetar y si se quiere abrir el proyecto.

3. Una vez abierto el proyecto se puede comprobar que hay un modulo Top
denominado ADC CONTROL. En el subdirectorio del proyecto se puede
observar que existen los siguientes archivos entre otros:

a. ADC_CONTROL.v, Es el archivo del disefio verilog que deben realizar
los alumnos. Se encuentra vacio, Unicamente contiene la cabecera de
declaraciones de sefiales de entrada y salida que deberan ser
respetadas para la elaboracion del disefio.

b. EMULE ADC.vo, Modelo de alto nivel del transmisor SPI para
comprobar la correcta implementacion del protocolo. Realiza una
emulacién del comportamiento de la parte tactil de la pantalla. (NO
MODIFICAR ESTE FICHERO).



c. MFB.v, Médulo donde se agrupan las tareas de acceso al DUV. (NO
MODIFICAR ESTE FICHERO).

i. gen_conversion: Simula la generacién de una conversion A/D en
el transmisor (entradas datos x / y)

ii. comprueba: Comprueba que los datos enviados por el
transmisor y los recibidos al final del periodo de transmision
sean iguales.

iii. reset. Generacion del reset con la temporizacién adecuada.
Incorpora una asercion para comprobar el efecto del reset en el
sistema

iv. generacion del reloj

d. tb_Touch Control.v, Testbench del disefio donde se instancian
MFB, EMULE_ADC, y el DUV (ADC_CONTROL). Asi mismo se
desarrollan los casos de verificacion que tendran que ser completados
con un envio mdultiple de datos y otras situaciones de riesgo que se
consideren oportunas. Para la elaboracion de los nuevos casos de test
deberan emplearse las tareas declaradas en el fichero MFB. v.

Realizar el disefio del bloque ADC_CONTROL, ajustandose a los
requerimientos temporales establecidos anteriormente.

Verificar el funcionamiento del bloque ADC_CONTROL, mediante simulacion
con ModelSim. En el apartado 2.2 (El Simulador Modelsim-Altera) de la pagina
16, se describen notas concretas del proceso de simulacién con ModelSim.
Una vez el disefio del ADC_CONTROL funcione correctamente, hay que
modificar el archivo tb_Touch_Control.v para incluir en el proceso de
verificacibn un segundo caso en el que se realicen tres comunicaciones
seguidas de tres datos distintos.

Una vez concluido el disefio y verificacion del ADC_CONTROL se puede
proceder con la realizacion de la siguiente tarea, que conlleva la verificacion en
placa.
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ADC_CONTROL

CLK ADC_DCLK

'y

RST n SCEN
ADC_BUSY
ADC_PENIRQ n

ADC_DIN

RARER

ADC_DOUT

X_COORD  Y_COORD

il !

Conversion a 7-segmentos

Figura 5.21. Diagrama del ejercicio de visualizaciéon del punto de “toque”.

5.6.9 Tarea 4.2 - Visualizaciéon del punto de contacto de la pantalla

Una vez se realizado el blogue de control del interface serie del convertidor ADC, un
buen ejercicio es mostrar el valor del punto de contacto en los visualizadores 7-
segmentos de la placa DE2, tal como se sugiere en la Figura 5.21. Dado que la
conversién es de 12 bits, se necesitan tres visualizadores para cada coordenada.
Representando en hexadecimal se obtendran los valores que se muestran en la Figura
5.22 para cada una de las esquinas del médulo LTM. En la Tabla 5.8, se puede ver la
asignacion de pines que debe realizarse a las sefiales de la FPGA de la placa DE2,
para utilizar el médulo LTM conectado al conector JP1.

{ X=12'hFFF,Y=0) ( X=12hFFF.Y =
12'hFFF )

(X=0.Y=0) (X=0,Y=12hFFF)

»
.
|
:
|
»
|
.
!
1
’
1
!
!
»
[

Figura 5.22. Valor de las coordenadas X e Y en las esquinas del médulo LTM.



5.6.10 Tarea 5 — Diseno libre

Un buen final de las practicas de la asignatura es realizar un disefio de un sistema
digital donde se demuestre todo lo aprendido a lo largo de las diferentes sesiones de
practicas. Como Uultima tarea se propone realizar un sistema que donde al menos se
fusionen la visualizacién en la pantalla y el uso de la funcién tactil.

5.6.11 Tarea 6 — Interface serie de la pantalla LCD

El interface serie de la pantalla LCD, permite ajustar diferentes aspectos de la
visualizacién en el médulo LTM, entre ellos la eleccion de la resolucion de la pantalla.
Inicialmente cuando se conecta la alimentacién, el médulo LTM funciona con unos
parametros de visualizacién por defecto, como por ejemplo una resoluciéon de 800x480
pixeles, que nos ha permitido trabajar hasta este momento. Sin embargo, si se desea
cambiar, entre otras cosas, la resolucion de la pantalla hay que realizar el disefio de un
blogue que permita comunicarse con la pantalla LCD por medio de su interface serie.

El interface serie de la pantalla LCD, consiste en una comunicacion serie sincrona, la
cual ha sido descrita anteriormente y que se muestra esquematicamente en el
diagrama temporal de la Figura 5.7. A la hora de realizar el disefio del interface serie,
hay que recordar algunos aspectos importantes: en primer lugar el interface serie de la
pantalla LCD comparte dos sefiales con el interface serie del convertidor ADC, la sefal
de reloj (ADC_DCLK) y la sefial de habilitacion (SCEN), en segundo lugar la linea de
datos (SDA) es bidireccional y por ultimo mientras se esté utilizando el interface serie
es necesario que se mantenga la sefal de reloj NCLK de la visualizacion de la pantalla
LCD.

El interface serie permite acceder a un total de 35 registros internos de configuracién
de la pantalla LCD. En la Tabla 5.10 se describe cada uno de esos registros.

Tabla 5.10. Registros internos de configuracion de la pantalla LCD.

Valor Lectura

Direccioén

Descripcién

Defecto | Escritura
0x00 0x00 R/W [7:0]: Registro de Test
0x01 0xC1 R [7:4]: Identificacion Chip, [3:0]: Version Chip
[7:6]: Seleccion del método de inversion del
punto.

[5]: Polaridad pulso sincronismo vertical. Por
defecto, activo a nivel bajo.

[4]: Polaridad pulso sincronismo horizontal. Por
defecto, activo a nivel bajo.

[3]: Seleccién del flanco activo del reloj NCLK. Por
defecto, flanco de bajada.

[2:0]: Seleccidn de la resolucion. Ver descripcion
en la Tabla 5.11.

0x02 0x07 R/W
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Direccion Descripcién

Valor Lectura

Defecto | Escritura
[7]: Seleccion de la resolucion y “standby” por
hardware o software.

[6]: On/off precarga.

[5:4]: Ajuste de la capacidad de salida.

0x03 Ox5F RW" | 13]: Onjoff salida PWM.

[2]: On/off salida VGL.

[1]: On/off salida CP_CLK.

[0]: Modo de funcionamiento (normal o espera).

[5:4]: Ajuste frecuencia VGL.

[3:2]: Ajuste frecuencia CP_CLK.
0x04 Ox17 RIW [1]: Modo vertical invertido.

[0]: Modo horizontal invertido.

[5:0]: Desplazamiento horizontal del display para
0x05 0x20 RIW el modo SYNC. Por defecto, centrado.

[3:0]: Desplazamiento vertical del display para el
0x06 0x08 RIW modo SYNC. Por defecto, centrado.

Ox07 0x20 RIW [5:0]: Ajuste de la anchura de pulso a nivel alto de

CKH.
0x08 0x20 RIW [5:0]: Ajuste de la anchura de no coincidencia de

CKH.

[5:0]: Ajuste de la anchura de no coincidencia
0x09 0x20 RIW entre el flanco de subida de ENB y de CKH.
OXOA 0x20 RIW [5:0]: Ajuste de la anchura de pulso a nivel bajo

de ENB.

:0]: Ajuste de la ganancia del contraste del color

5:0]: Aj del ia del del col
0x0B 0x20 R/W rojo. Ajustable entre 0 y 1,96875 (Ox3F), por

defecto a 1 (0x20).

[5:0]: Ajuste de la ganancia del contraste del color
0x0C 0x20 R/W verde. Ajustable entre 0 y 1,96875 (0x3F), por
defecto a 1 (0x20).

[5:0]: Ajuste de la ganancia del contraste del color
0x0D 0x20 R/W azul. Ajustable entre 0y 1,96875 (0x3F), por
defecto a 1 (0x20).

[5:0]: Ajuste del nivel de brillo en el color rojo.
OxOE 0x10 R/W Ajustable entre -16 (0x00) y 47 (Ox3F), por
defecto a 0 (0x20).

[5:0]: Ajuste del nivel de brillo en el color verde.
OxOF 0x10 R/W Ajustable entre -16 (0x00) y 47 (Ox3F), por
defecto a 0 (0x20).

[5:0]: Ajuste del nivel de brillo en el color azul.
0x10 0x10 R/W Ajustable entre -16 (0x00) y 47 (Ox3F), por
defecto a 0 (0x20).

Correccion Gamma (ver diagrama en Figura
5.23):

[7:6]: Bits [9:8] del segmento GAMMA 0.

[5:4]: Bits [9:8] del segmento GAMMA 8.

[3:2]: Bits [9:8] del segmento GAMMA 16.

[1:0]: Bits [9:8] del segmento GAMMA 32.

Ox11 0x00 R/W




Direccion Descripcién

Valor Lectura

Defecto | Escritura
Correccion Gamma (ver diagrama en Figura
5.23):

[7:6]: Bits [9:8] del segmento GAMMA 64.

[5:4]: Bits [9:8] del segmento GAMMA 96.

[3:2]: Bits [9:8] del segmento GAMMA 128.

[1:0]: Bits [9:8] del segmento GAMMA 192.
Correcciébn Gamma (ver diagrama en Figura
5.23):

[7:6]: Bits [9:8] del segmento GAMMA 224.

[5:4]: Bits [9:8] del segmento GAMMA 240.

[3:2]: Bits [9:8] del segmento GAMMA 248.

[1:0]: Bits [9:8] del segmento GAMMA 256.

[7:0]: Correcciébn Gamma, bits [7:0] del segmento
GAMMA 0. Ver diagrama en Figura 5.23.

[7:0]: Correcciébn Gamma, bits [7:0] del segmento
GAMMA 8. Ver diagrama en Figura 5.23.

[7:0]: Correccion Gamma, bits [7:0] del segmento
GAMMA 16. Ver diagrama en Figura 5.23.

[7:0]: Correcciébn Gamma, bits [7:0] del segmento
GAMMA 32. Ver diagrama en Figura 5.23.

[7:0]: Correccion Gamma, bits [7:0] del segmento
GAMMA 64. Ver diagrama en Figura 5.23.

[7:0]: Correccién Gamma, bits [7:0] del segmento
GAMMA 96. Ver diagrama en Figura 5.23.

[7:0]: Correcciébn Gamma, bits [7:0] del segmento
GAMMA 128. Ver diagrama en Figura 5.23.

[7:0]: Correcciébn Gamma, bits [7:0] del segmento
GAMMA 192. Ver diagrama en Figura 5.23.

[7:0]: Correccién Gamma, bits [7:0] del segmento
GAMMA 224. Ver diagrama en Figura 5.23.

[7:0]: Correcciébn Gamma, bits [7:0] del segmento
GAMMA 240. Ver diagrama en Figura 5.23.

[7:0]: Correcciébn Gamma, bits [7:0] del segmento
GAMMA 248. Ver diagrama en Figura 5.23.

[7:0]: Correcciébn Gamma, bits [7:0] del segmento
GAMMA 256. Ver diagrama en Figura 5.23.

[7:4]: Define la tension positiva de referencia del
DAC para el cédigo FFH.

[3:0]: Define la tension positiva de referencia del
DAC para el codigo O0H.

[7:4]: Define la tensién negativa de referencia del
DAC para el cédigo FFH.

[3:0]: Define la tension negativa de referencia del
DAC para el codigo O0H.

0x22 0x05 R/W [3:0]: Ajuste del nivel de continua de VCOM.

0x12 0x5B R/W

0x13 OxFF R/W

0x14 0x00 R/W

0x15 0x20 R/W

0x16 0x40 R/W

ox17 0x80 R/W

0x18 0x00 R/W

0x19 0x80 R/W

Ox1A 0x00 R/W

0x1B 0x00 R/W

0x1C 0x80 R/W

0x1D 0xCO R/W

Ox1E OxEO R/W

Ox1F OxFF R/W

0x20 0oxD2 R/W

0x21 0oxD2 R/W




Tabla 5.11. Descripcién del registro de configuracion de la resolucion de la pantalla LCD.

Secuencia Secuencia

R02[2:0] Entrada Salida Observacion

0 0 0 400xRGBx240 800xRGBx480 | Dual Scan
0 0 1 480xRGBx272 800xRGBx480 | Dual Scan
0 1 0 Valor prohibido
0 1 1 Valor prohibido
1 0 0 Valor prohibido
1 0 1 480xRGBx272 | 480xRGBx272
1 1 0 Valor prohibido
1 1 1 800xRGBx480 | 800xRGBx480 | Valor por Defecto
A
YMmi-———————-—-—-—— — — — — —
Yobm———_- - - — — — — — — — — - — |
Yopb——— " —-"—-————
Y8 ——————————————— I I I
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Figura 5.23. Diagrama de la correccion Gamma.
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